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Chapter 1: Introduction

What is Harmony?
Harmony is a revolutionary team-based infrastructure for animation production. Its array of cutting-edge
features increases productivity and encourages creativity. Developed in conjunction with leading studios
worldwide, Harmony is specifically designed for long-term episodic and feature length projects, providing a true
animation pipeline. Several animators can work simultaneously on the same scene while the asset library
provides users with easy access to up-to-date media assets.
Harmony is truly scalable; more than 100 staging clients can share animation just as easily as a few can. Whether
you are a start-up studio or a large established animation facility, Harmony serves as the animation backbone
ensuring sustainability and growth.
Harmony is a powerful solution that brings together multiple teams working on the same project, whether inhouse or remotely. The Harmony solution offers a robust asset management system that enables users to
quickly locate assets, share tasks on complex scenes and centralize all assets in a common repository.
Tremendous gains in efficiency and quality are made by the teams, who enjoy a smooth flow between each task,
and more time dedicated to their creative assignments.

What is Toon Boom Harmony Server?
At the heart of the Harmony Solution is the server, which centralizes all the production assets in a repository.
Loaded with production proven tools to manage administration tasks, the server is completely flexible and will
fit in your existing infrastructure, whether you are on Windows, Linux or Mac.
In addition, the server is critical at the end of a production for rendering projects efficiently. The Render module,
controlled directly by the server, not only renders production scenes but also executes the batch vectorization of
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What is Contained in this Guide?

the scanned drawings. Connect an unlimited number of Render nodes and change priority depending on the
deadline! You can also render final frames locally, or batch process over a network in the background or at
scheduled times.

What is Contained in this Guide?
The Toon Boom HarmonyServer User Guide was created to help you set up and manage your Toon Boom
Harmony Server and your rendering queue.

Topics Covered
•

Control Center Module on the facing page

•

Batch Processing on page 63
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Chapter 1: Control Center Module
Using the Harmony solution and the Toon Boom Harmony Server has the advantage that it centralizes your
whole production on your server and organizes it into a structured database. The key piece of Toon Boom
Harmony Server is the Control Center module. From the Control Center, you can manage your production
database, users, visualize your rendering queue and more.
This chapter explains the general administrative tasks which must be performed to successfully run the Harmony
Solution.

Topics Covered
•

Launching Control Center on the next page

•

Centralized Data and Global Locking on page 15

•

Creating Harmony Users on page 17

•

Managing Environments, Jobs and Scenes on page 24

•

Exporting and Importing Data on page 47

•

Control Center Commands on page 55
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Launching Control Center

Launching Control Center
To manage a production, you will need the Control Center module. The Control Center is used to create new
environments, jobs, scenes and users as well as to import and export scene packages. The Control Center
directly manages your server database and is the only place you can create scenes in your database.

You can launch the Control Center from the server or any client machine.

Before accessing the main Control Center interface, the Database Login dialog box opens requesting a
username. By default, there is a username created; usabatch. Type this username to log in the first time. Once
logged into Harmony, you will be able to create your own set of users

Do not delete the usabatch username. It is used by Toon Boom Harmony Server for the batch
processing task.
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To open Control Center:
1. To launch Control Center:
‣

Windows:
Select Start > All Programs > Toon Boom Harmony 10.0 > Control Center.

‣

Mac OS X:
Select Finder > Applications > Toon Boom Harmony 10.0 > Control Center.

‣

Linux:
/usr/local/ToonBoomAnimation/harmony_10/ln86/bin/Controlcenter

You can also type Controlcenter in a command shell window.
You can also select Applications > ToonBoom-Harmony_10.0 > Control Center.
The Database Login dialog box opens.

2. In the User Name field, type usabatch, this is the default Harmony user.
The Control Centerapplication opens.
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Launching Control Center

Related Topics
•

Control Center User Interface below

Control Center User Interface

The Control Center interface is divided into 6 areas:
•

Top Menu
The top menu contains all the commands available in Control Center. You can also find the commands in
the contextual menus available in each area by right-clicking.

•

Environments
The Environments area shows one of your projects such as a feature film, a TV series or a group of TV
spots.

•

Jobs
The Jobs area shows the sequences or episodes in your project (Environment). You can only see your jobs
once you select a project in your Environments list.

•

Scenes
The Scenes area shows the scenes in your episode or sequence (Job). You can only see your scenes once
you select a job in your Jobs list.

•

Elements
The Elements area shows the layers or columns in your scene. You can only see your elements once you
select a scene in your Scenes list.

•

Drawings
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The Drawings area shows the drawings in your layer or column (Element). You can only see your drawings
once you select an element in your Elements list.
Here is a typical example of the database structure:

Collapsing and Expanding the Control Center
You can collapse and expand the Elements and Drawings sections of the user interface. As the elements and
drawings are not created in Control Center, these sections are used less often. To simplify the interface, you can
click on the Collapse/Expand
button to show or hide the Elements and Drawings sections.
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Launching Control Center

Related Topics
•

Managing Environments, Jobs and Scenes on page 24
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Centralized Data and Global Locking
When working with the Harmony solution and Toon Boom Harmony Server, all scenes and their data are stored
directly on the server, no data is saved or stored on the client machine. The client machines access the database
and load the scenes and drawings directly from the server. Each time the user saves his scene, the data is
updated directly on the server. There are no upload or download operations done between the server and the
clients.
Harmony has a lock system, referred to as Global Lock, for the different scenes and scene assets. As all the data
on the server can be accessed directly and modified from any client machine, by default, the scenes are locked
and the users need to get the rights to modify them in order to save their work onto the server. Only one user at
the time can modify a scene. Once a scene is opened on a client machine, the other users can only open the scene
in read-only mode if they need to consult it, but they will not be able to save any modifications.
The Global Lock has three levels:
•

Get rights to modify the scene
Allows the user to modify the selected version of the scene and have access to the version manager during
the opened session.

•

Get rights to modify the scene version
Allows the user to modify the currently selected scene version but locks access to the version manager
during the opened session.

•

Get rights to modify the scene assets
Automatically gets all the edit rights for the selected version of the scene. This option is only
recommended if you are certain that the selected scene can not be opened for editing by several users at
the same time. Large studios should avoid this option.

There are several different ways to get the rights to modify the scenes. This can be done when:
•

the user loads a scene

•

an environment is created

•

a job is created

•

a scene is created

•

or in the user's preferences
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Centralized Data and Global Locking

Related Topics
•

Managing Environments, Jobs and Scenes on page 24 topic.
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Creating Harmony Users
In an animation studio, you will generally have several people using Harmony who will probably be assigned
different tasks such as Ink and paint or compositing. You should normally create a different user for each one of
them. This way, the person assigned to ink and paint will only access the Paint module and not to other functions
that are not relevant to his work.
•

Viewing the Current User List below

•

Adding a User on the next page

•

User Types and Restrictions on page 19

Viewing the Current User List
Everyone who uses Harmony must have a login name in order to run any of the modules. The Harmony login is
independent from the computer session login.
To view the user list:
1. In the top menu, select Admin > Users.
The User List dialog box appears and displays your login name and a list of the other users in the system.

By default, only the usabatch and BATCH users are created. You should not use those for your staff. These
should be kept for the Toon Boom Harmony Server when performing background operations such as the batch
processing.
The User List dialog box lists all the users and their details, including; username, first and last names, and user
type. The buttons at the bottom of the dialog box let you add, delete or modify the list of users.
The different modules and applications in which a user can log in are:
•

Control Center module

•

Stage module

•

Paint module

•

Xsheet module

•

Scan module

•

Play module
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Adding a User

Adding a User
All Harmony users must have their name on the user list to log in to any application. The system uses the login to
track activities; it is not a security lockout.
Each login also has a user "type" assigned to it which allows access to only some of the Harmony modules.
To add a user to Harmony:
1. To view the list of Harmony users, select Admin > Users.
The User List dialog box appears.

2. Click on the Add button.
The Add User dialog box appears.

3. In the User Name field, type the person's user name.

Make sure that the user name does not exceed the 12-character limit.

4. Type the person's first name and last name in the corresponding First Name and Last Name fields. You
can enter a space if you want leave the field blank.
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5. In the Type drop-down menu, select the user type. This defines the type of work the user typically
performs. It will allow or block the person to access certain Harmony applications and perform
operations in Control Center.

6. Click OK to complete the user creation process or click Cancel to abort it.
The Add User dialog box disappears and the name appears in alphabetical order in the user list.

User Types and Restrictions
Here are the different user types available and their restrictions:
•

R&D: The user is a part of the Research and Development department. No restrictions.

•

Executive: The user is an executive producer in the studio. No restrictions.

•

Coordinator: The user is a project coordinator in the studio. No restrictions.

•

TD: The user is a technical director. No restrictions.

•

Xsheet: This user type is used for the Xsheet team, animators and compositors. Access to all Harmony
applications.
The user is UNABLE to:

•

•

Delete jobs or scenes from the environment

•

Force the lock on a scene from Control Center

•

Move a scene

•

Clear the Xsheet

•

Rename a scene

Scan: ONLY has access to the Scan, Play and Paint modules.
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User Types and Restrictions

The user is UNABLE to:

•

•

Delete jobs or scenes from the environment

•

Force the lock on a scene from Control Center

•

Move a scene

•

Clear the Xsheet

•

Rename a scene

•

Access the Stage and Xsheet modules

Ink & Paint: ONLY has access to the Paint and Play modules.
The user is UNABLE to:

•

•

Delete jobs or scenes from the environment.

•

Force the lock on a scene from Control Center

•

Move a scene

•

Clear the Xsheet

•

Rename a scene

•

Access the Stage, Scan and Xsheet modules

The Archive and Application categories are not user types. They are used for batch processing and other
programs; do not assign them as user types.

Description

RD - Coordinator
Executive Archive
Application - TD

Create environments, jobs and
scenes
Unlock scenes locked by another
user.
Move, rename, delete and clear:
environments,jobs and scenes
Launch the Xsheet and Stage
modules

Launch the Scan module

Launch the Paint module
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Related Topics
•

Deleting a User below

•

Modifying User Profiles below

•

Creating a Default User for Batch Processing on page 23

Deleting a User
As your studio network grows and evolves, you may need to delete old or obsolete user profiles from your
system. After you delete a user profile, the person who used that profile will no longer be able to access
Harmony.
You cannot delete yourself from the user list. If you accidentally delete a name, you must follow the procedures
for adding a user to get the name back into the system.
To delete a user:
1. To view the list of users, select Admin > Users.
The User List dialog box appears.

2. In the user list, select the name you want to delete.
3. Click on the Delete button.
The Confirm dialog box appears.

4. Confirm if you want to delete the user from Harmony.
‣

Click OK to delete the selected user.

‣

Click Cancel to abort the delete command.

Related Topics
•

Creating Harmony Users on page 17

Modifying User Profiles
You can modify the user profiles at any time to update the user information.

21

Chapter 1: Control Center Module

User Types and Restrictions

You can only change other user profiles. If you log in using your personalized login name, you will not be able to
modify your own user profile.

To change your own user profile, login as usabatch (the default user).

To modify user information:
1. To view the list of users, select Admin > Users.
The User List dialog box appears.

2. Select the profile to modify.
3. Click on the Modify button.
The Modify User dialog box appears.

4. Type or select the new information in any or all of the following:
‣

User Name: the user's login name

If you modify the user name, make sure that it does not exceed the 12-character limit.

‣

First Name: the user's given name

‣

Last Name: the user's family name

‣

Type drop-down list: the type of access the user has in the system

5. Click on the OK button to complete the update or click Cancel to abort it.
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Related Topics
•

Managing Environments, Jobs and Scenes on the next page

Creating a Default User for Batch Processing
If you intend to use the batch processing feature in Harmony or if you are installing the application on the server
machine, you must create:
•

An operating system user called usabatch

•

A Harmony User Name called usabatch through the Control Center module.

Harmony uses this user profile during the batch rendering.

It is important to verify that these users exist before starting a project and setting the batch
processing.

•

Operating System Users
•

If you installed Harmony in Windows, the usabatch operating system user profile was automatically
created by the installation wizard.

•

If you installed Harmony in Mac OS X, the usabatch operating system user profile must be created
manually or using the configuration assistant.

•

If you installed Harmony in Linux, you must manually create the usabatch operating system user.

In all cases, a user account on your operating system called usabatch must exist. If you need to create
this account, see your system administrator for more information on how to do this.
•

Harmony User Names
•

The usabatch Harmony user is created during the installation process on Windows, Mac OS X and
Linux. There is no need to create it manually unless it was deleted. To create manually the usabatch
Harmony user, refer to the section.

Related Topics
•

Creating Harmony Users on page 17

•

Deleting a User on page 21
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Managing Environments, Jobs and Scenes

Managing Environments, Jobs and Scenes
Every project you create with the Harmony solution starts with an environment; it is your highest level in the
Control Center module. You can build a complete environment by adding jobs, scenes, elements and drawings.
The Control Center module divides your animation project into the following categories which organize the
components of your animated projects:

•

Environment: This is the name of your animation project.
Example: adventure_movie

•

Jobs: These are the major sections of an Environment such as sequences or episodes.
Example: adv_seq_001, adv_seq_002

All jobs are stored in the same location in the Harmony database. Prefix all job names appropriately,
so you can identify the project it belongs to. Each job must have a different name. You cannot give
two jobs the same name.

•

Scene: These are the different shots in a Job.
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Scenes are contained under their respective job folder in the Harmony database. Prefix all scenes names
appropriately, so you can identify which environment and job they belong to.
Example: sc_001, sc_002
•

Elements: These are the different layers and columns in your scenes.
If you have not created an exposure sheet yet, the Frames column in the Scenes list displays 0 and no
elements appear in the Elements list or the Drawings list.
For example, scene 002 of show_episode_6 could have the following elements:
•

a background called bg

•

a character called tony

•

a highlight effect called hl

You would then find these elements under job 002 and the show_episode_6 scene. The Elements list
would display the element names, types of elements in a scene, the type of scans, and the size of the field
chart.
•

Drawings: These are actual drawings of the elements (layers) in your scene.
For example, the tony element in 002 of show_episode_6 could consist of 35 drawings. To find these
drawings, you would look under Drawings to see the keyframes, state, and stage of each drawing.

As your projects come and go, you'll probably want to start cleaning up your database, not to mention your
server's hard disk, by removing old and obsolete Environments and their associated animation data.

After you delete a scene, a job, or an environment, the associated data is permanently removed
from your storage disks. Make sure you really want to erase these items before you delete them;
there's no way of retrieving the data that has been erased.

You might want to export old environments and archive them somewhere else before you delete them from your
system.

If you are working in a mixed Windows/Linux/Mac OS X environment, or share files with other
studios that do, you should use lower case letters to name the various items in your animation
projects and not include any spaces in components name (for example, write the_show instead of
The Show. This recommendation is due to the fact that Linux is case-sensitive while Windows is not.

Related Topics
•

Managing Environments on the next page

•

Managing Jobs on page 29

•

Managing Scenes on page 34

•

Viewing Elements and Drawings on page 46

•

Exporting Data on page 47
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Managing Environments, Jobs and Scenes

Managing Environments
Harmony uses environments to manage and organize related projects. Using environments allows you to
organize your production projects by their nature or type.
If your projects centre around episodic and commercial types of work, you could create two environments for
instance one called commercials and the other called the_show and insert the jobs that relate to each type
of project. When you want to work on a commercial project, open the commercials environment and select
the commercial job you need. Similarly, if you want to work on an episodic project open the environment called
the_show.
Environment

Job
sc_001

commercials

the_show

dentist
sc_002
soda

sc_001

cereal

sc_001

sho_001

sc_001
sc_002

sho_002

sc_001

Related Topics
•

Creating an Environment below

•

Deleting an Environment on the facing page

•

Setting the Resolution.conf File on page 28

•

Managing Jobs on page 29

•

Managing Scenes on page 34

Creating an Environment
To create an Environment:
1. In the top menu, select Environment > Create or you can also right-click in the Environments section and
select Create.
In mixed platform Environments (Linux and Windows or Mac OS X and Windows) it is best to name
everything in lower case so that data can be interpreted the same on each operating system. The same is
true if working between studios using Windows, Linux and Mac OS X.
The Create Environment dialog box appears.
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2. Type the new project's name in the Environment Name field.

The environment name is alphanumeric and can include underscores (_), but no spaces or other
special characters. The environment name is case sensitive.

3. If you want the user to automatically get the rights to modify all the scene assets (drawing, scene setup,
palette lists, etc.), enable the Get Rights to Modify All Scene Assets option.

4. Click on the OK button to complete the operation.
The new environment appears in alphabetical order in the Environments list.
After you create an environment, you must add it to the Batch Processing queue so that it can vectorize and
render the drawings and scenes automatically. You only have to add the environment to the Batch Processing
queue once.

Related Topics
•

Centralized Data and Global Locking on page 15

•

Viewing the Vectorize Queue on page 82

•

Deleting an Environment below

Deleting an Environment
When you are ready to remove old environments, you can delete them from the database. However, in order to
prevent accidental loss of data, you can only delete an empty environment (an environment that contains no jobs,
image, or palette information).
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Managing Environments, Jobs and Scenes

To delete an environment:
1. In the environment section, select the environment you want to delete from the Environments list.
2. Select Environment > Delete or you can also right-click on the selection and select Delete.

The Delete command is only available for an empty environment. You must delete the scenes and
jobs before you can successfully delete the environment.

3. The Confirm dialog box appears.

‣

Click on the Yes button to delete the selected Environment.

‣

Click on the No button to abort the delete command.

The environment no longer appears in the Environments list.

Related Topics
•

Deleting a Job on page 33

•

Deleting a Scene on page 45

Setting the Resolution.conf File
When you create a new environment or job, you can create a project resolution list that will appear in Harmony
Stage. If you work with a particular resolution, you can insert it in your list and have it set and available when
doing the compositing in Harmony Stage.
You need to insert the Resolution.conf file in the Environment or Job folder. If you insert the file at the
environment level, it is not necessary to add one at the job level.
The Resolution.conf file can be found in:
•

Windows: Program Files > Toon Boom Animation > Harmony 10.0 > resources > samples

•

Mac OS X: Applications > Toon Boom Harmony 10.0 > tba > resources > samples

•

Linux: /usr/local/ToonBoomAnimation/harmony_10.0/resources/samples

Insert the Resolution.conf file in the following directory:
•

/USA_DB/environments/environment_name/resolution.conf
Resolutions common to all jobs in the environment.

•

/USA_DB/db_jobs/job_name/resolution.conf
Resolutions common to all scenes in the job.

•

/USA_DB/resolution/resolution.conf
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Resolutions common to all scenes and all environment.
All scenes found under the environment or job have access to the resolutions stored in that file.
You can simply type new resolutions, modify or delete existing ones from the list. This file can also be sent to
other studios with whom you may be working.

Related Topics
•

Managing Environments on page 26

Managing Jobs
Within each environment is a list of jobs. These Jobs contain all the segments for your animated sequence. If you
are creating a weekly television series called The Show, you could name your job show_ep_06 (the_show
could be the name of your environment).
If each episode was composed of 100 animated shots, each job would contain 100 scenes.

Related Topics
•

Creating a Job below

•

Updating Jobs on page 31

•

Deleting a Job on page 33

Creating a Job
Each job must have a unique name. You cannot have two jobs with the same name, even if they appear in two
different environments. On the server, all the jobs are contained in the same folder.
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To create a job:
1. In the Environments section, select the project in which you want to create your new job.
2. In the top menu, select Job > Create or you can also right-click in the Jobs section and select Create.
The Create Job dialog box appears.

3. In the Name field, type the name of the job you want to create.

The job name is alphanumeric and can include underscores (_), but no spaces or other special
characters. The job name is case sensitive.

4. In the TD drop-down menu, select a technical director (TD). You must select a technical director to create
the job.
A TD is usually the person who oversees the animation project and makes sure the work is done properly.
Select the person who most closely resembles this definition. If you do not have a particular user for the
task, you can simply assign usabatch.
When you create your Harmony users, you can label a user as a technical director (TD).
5. In the ATD drop-down menu, select an assistant technical director (ATD). You must select an assistant
technical director to create the Job. If you don't have an ATD select the same person for the TD and ATD
jobs.
In some studios, the responsibilities of the technical director can be shared by more than one person. This
second person is the ATD.
The technical director and assistant technical director you select appear in the Scenes list for each scene
of the job.
6. In the Approval drop-down menu, select how Harmony will mark the various stages the scenes will pass in
your production schedule.
‣

Automatic: When you work on your scenes, Harmony automatically approves their status at each
stage

‣

Manual: When you work on the scenes, the technical director or the assistant technical director must
approve their status at each stage using the Change Stage command (available in the Scene menu).

7. Drag the Priority slider handle to increase or decrease the job's priority (0 means the Job has the highest
priority for processing through the Vectorize or Render queue and a job with a priority of 10 is the least
important). Jobs with higher priorities will pass in front of other projects with lower priorities in the
rendering and vectorizing queues even if there is already a queue processing.
If you do not know what priority to assign to your project, you can leave it at 5. You always have the
possibility to change it later.
8. Click on the OK button to complete the operation.
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The Control Center module adds your new job to the selected environment and it appears in alphabetical
order in the Jobs list.

Related Topics
•

Changing a Scene's Stage on page 40

•

Changing a Job's Queue Priority on the next page

•

Updating Jobs below

Updating Jobs
As you continue working on your animation project, you may want to update the status of the jobs in your
environment. This status can display one of three things:
•

The stage the job has reached

•

When the job will be vectorized

•

When the job will be rendered

Related Topics
•

Changing a Job's Stage below

•

Changing a Job's Queue Priority on the next page

Changing a Job's Stage
As you complete your animation project, you can update a job's status to reflect where it is in the overall
production process. You can classify jobs as being In Production or Completed.
•

In Production: The Job is still a work in progress. The other modules can still access this Job.

•

Completed: The Job is finished. The Harmony database still has all the job's components (scenes,
elements, drawings), but the job neither appears nor is accessible from the Harmony applications.
In most cases, you would mark a Job as Completed after it has been finalized (inked, painted, rendered)
and transferred to a medium like tape or sent to post-production.
You can change a job's status from Completed to In Production at any time to continue working on it.

If you want to remove a job and its data from the Harmony database and archive it, you can export the Job from
Control Center.
To change the stage of a job and view the list of completed jobs:
1. In the Environments section, select an environment.
2. In the top menu, select Job > Change Stage or you can also right-click in the Jobs section and select
Change Stage.
The Change Stage of Jobs window appears.
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3. Select the jobs you want to change the stage.
‣

If you want to change a job from In Production to Completed, select the jobs in the In Production list.

‣

If you want to change a job from Completed to In Production, select the jobs in the Completed list.

4. Click one of the Change buttons to change the job's status.
‣

Click the Change to Completed

‣

Click the Change to In Production

button to change a job that is in production.
button to change a job that is completed.

5. Click on the OK button when you finish making changes.

Related Topics
•

Exporting and Importing Data on page 47

Changing a Job's Queue Priority
Before you send a job's scenes to be vectorized or rendered, you can change the job's priority level in the
processing queue. Increasing a job's priority lets the system process it before other jobs in the processing
queue.
Use the Choose New Priority dialog box to change a job's rendering and vectorization queue priority. The
priority is set using a sliding scale where 0 is the highest priority and 10 is the lowest.
For example, If Job B is before Job A in the queue, you can change the priority so that Job A is processed first.

Changing's a job's priority doesn't affect vectorizing or rendering Jobs that are already sent in the
queue. It will only affect Jobs that are sent after making the change. If you want to change a job's
priority after it's been sent to the queue, use the Change Priority button in the Queue window.

To change a job's priority:
1. In the Environments section, select the environment containing the job you want to change the priority
for.
2. In the Jobs section, select the job whose priority you want to change.
3. In the top menu, select Job > Change Priority or you can also right-click in the Jobs section and select
Change Stage.
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The Choose New Priority dialog box appears.

4. Drag the slider to the desired priority (0 means the Job has the highest priority for processing through
the Vectorize or Render queue and a job with a priority of 10 is the least important).
5. Click on the OK button. When you send this job to be vectorized or rendered, it will have this new priority
in the processing queue.

Related Topics
•

Modifying Entries in the Vectorize Queue on page 84

•

Modifying the Entries in the Render Queue on page 88

Deleting a Job
You should only delete jobs that you no longer need or that have already been exported to an archive (using the
Export command available in the Admin menu).
When you delete a job, it permanently removes all of the following components:
•

Scenes

•

Elements

•

Drawings

•

Database information associated with the selected Job

•

Palettes stored under the selected Job

Before you delete a job:
•

Make sure no one else is currently using the Job.
Failure to do this may result in file corruption and loss of your work.

•

Wait until everyone is offline.
This ensures no one can open the data files while you delete them.

You cannot archive a job by deleting the job from the Control Center module.

If you want to archive a job, you should export it to a new location where it can be stored permanently.
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Changing the job's stage from In Production to Completed only hides the job in the Control Center window; all
the associated files with the Job are still on your system.
To delete a job:
1. In the Environments section, select the environment containing the job you want to delete.
2. In the Jobs section, select the job you want to delete.
3. In the top menu, select Job > Delete or you can also right-click in the Jobs section and select Delete.
4. The Confirm dialog box appears.

If there are many scenes in the job, the deleting process could take several minutes.
‣

Click on the Yes button to delete the Job.

‣

Click on the No to cancel the delete command.

Related Topics
•

Exporting and Importing Data on page 47

•

Changing a Job's Stage on page 31

Managing Scenes
After you create a scene, you can view corresponding elements and drawings in the Control Center window.
When you select the environment and the job, the corresponding scenes for the selected Job appears in the
Scenes list in the Control Center window.
For each scene in your job, you must create a unique exposure sheet to lay out the drawings, the camera effects,
the audio tracks, and other special effects for that scene.

Related Topics
•

Creating a Scene below

•

Updating Scenes on page 37

•

Deleting a Scene on page 45

Creating a Scene
When creating your scene, you must select the path where you want to store the scene data and where you want
the new scene to appear in the Scenes list. You can create a single scene or create multiple scenes all at once.
To create a scene:
1. In the Environments section, select the environment containing the job you want to add scenes in.
2. In the Jobs section, select the job you want to add scenes in.
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3. In the Scenes section, select Scene > Create or you can also right-click in the Scenes section and select
Create.
The Create Scene dialog box appears.

4. Click in the Scene Name(s) field and enter the name for the first scene you want to create.
5. Press the [Enter/Return] keyboard shortcut to move onto the next scene.
6. Enter the name of the next scene you want to create.

When creating a new scene or when renaming a scene, the scene's name cannot exceed 23
characters.

When creating scenes in the Control Center module, you should enter the scene names exactly as they
appear on the actual animation. This ensures that the information in your environment is consistent with
the actual animation.

The job and scene names are alphanumeric and can include underscores (_), but no spaces, or other
special characters. The Environment name is case sensitive.

You do not have to enter the word scene when entering scene names. The system automatically
adds scene- in front of the name you enter.
For example, enter"3" in the Scene Name field, the scene name automatically displays as "scene-3"
throughout the file system. The scene name will have scene- as a prefix, but that will only be visible
when looking at the scene on the file system. The scene will appear without the scene- prefix in all
the Harmony applications.

7. Repeat the previous steps until you named all the scenes you want to create.
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8. In the File System list, click the path where you want to store the files.
If you do not see the desired path in the list, specify a different path in the Other File System field.
If you are unsure which disk drive to select, consult your technical director or system administrator.
The information in the File System list displays:
‣

Available drives on which you can store new scenes

‣

Space that is currently available (in megabytes)

‣

The percentage of space the drives are currently using

Although you can add as many scenes as you wish, you can only select one path at a time. Therefore,
the Control Center module stores all scenes you create in one session at the same place (same path).

9. Select where you want to place the scene in the Scenes list from the Add Scenes drop-down list. You have
the following options:
•

At Bottom: Places the new scenes at the bottom of the list

•

At Top: Places the new scenes at the top of the list

•

Before Selected: Places the new scenes above the selected scene

•

After Selected: Places the new scenes below the selected scene

•

Name Sort: Arranges the new scenes alphabetically

To use the After Selected and Before Selected options, you must select another scene from the
Scene list in the Control Center window.

10. Click OK in the Create Scene dialog box.
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The system creates the new scene and displays it in the Scenes list. If you don't want to create the scene,
click Cancel.

Related Topics
•

Managing Scenes on page 34

Updating Scenes
Your scenes contain the animation sequences your are working with, this allows you to manipulate them and
their associated files to achieve the desired effect. With Harmony you can perform the following functions:
•

Moving a Scene below

•

Renaming a Scene on the next page

•

Changing a Scene's Priority on page 39

•

Changing a Scene's Stage on page 40

•

Changing the Sequence of Scenes on page 41

•

Clearing Scenes from Control Center on page 42

•

Copying an Exposure Sheet to Another Scene on page 42

•

Send Scenes to the Render Queue on page 44

Moving a Scene
When you create a scene, it and its associated files are stored on one drive. If you find you are running out of
space you can move a scene to another drive. However, you can consolidate all the scenes for a particular Job in
a single directory allowing you to find related information quickly. You may also want to file your scenes in
specific directories, creating a customized directory system. The Move command lets you move scene data from
one file system to another.
Before you move a scene's data:
•

Make sure no one else is currently using the scene's data.
Failure to do this may result in file corruption and loss of your work.

•

Wait until everyone is offline.
This ensures no one can open the data files while you move them.

To move a scene from one directory to another directory:
1. In the Scenes section, select the scenes you want to move.
2. In the top menu, select Scene > Move. You can also right-click anywhere in the Scenes list and select
Move.
The Move Scene dialog box appears.
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3. In the Select Scene(s) to Move field, select the scenes you want to move from their current directory.
4. Click on the Calculate button to know how much hard disk space your selection requires.
5. In the Move Scenes To list, select the directory where you want to move the scene. If the directory to
where you want to move the scenes does not appear in the list, in the Other field, enter the new directory
path.
The Control Center module automatically checks the amount of free space for each directory and
compares it to the size of the scene you want to move.
If there is not enough disk space on a particular drive/mount point to store the scene, the directory
displays a not enough space message. If there is not enough space on a particular disk, you should
choose another disk from the list.
6. Click on the OK button.

Related Topics
•

Updating Scenes on the previous page

Renaming a Scene
As you work on your scenes, their nature and contents may change and the name you gave the scene when you
began the project may no longer reflect its contents. In this case, you can rename the scene to more accurately
reflect its contents.
Before you rename a scene:
•

Make sure no one else is currently using the scene.
Failure to do this may result in file corruption and loss of your work.

•

Wait until everyone is offline
This ensures no one can open the scene while you rename it.

To rename a scene:
1. In the Scenes section, select the scene to rename.
2. In the top menu, select Scene > Rename. You can also right-click anywhere in the Scenes list and select
Rename.
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The Rename Scene dialog box appears.

3. In the Enter New Scene Name field, type the new name for the scene and click OK. Try to keep scene
names brief. It is recommended that you use no more than 23 characters.

Use lower case letters if these scenes may be used with a Windows workstation.

When creating a new scene or when renaming a scene, the scene's name cannot exceed 23
characters.

Related Topics
•

Updating Scenes on page 37

Changing a Scene's Priority
You can change the scene's priority level in the processing queue. Increasing a scene's priority lets the system
process it before other scenes in the processing queue.
Use the Choose New Priority dialog box to change a scene's rendering and vectorization queue priority. The
priority is set using a sliding scale where 0 is the highest priority and 10 is the lowest.
For example, If Scene B comes before Scene A in the queue, you can change the scene's priority so that Scene A
will be processed first.

If a scene has already been sent to the queue changing the priority at this point will not affect its
priority in the queue. Changes will only be applied next time it is sent to the queue. To change a
scene's priority after it's been sent to the queue, use the Change Priority button in the Queue
window.

To change a scene's priority:
1. Select the environment, the job and the scene you want to prioritize.
2. In the top menu, select Scene > Change Priority. You can also right-click anywhere in the Scenes list and
select Change Priority.
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The Choose New Priority dialog box appears.

3. Drag the slider to the desired priority (0 means the job has the highest priority for processing through the
Vectorize or Render queue and a Job with a priority of 10 is the least important).
4. Click on the OK button.
The new scene priority appears in the Scenes list in the Priority column.

Related Topics
•

Modifying Entries in the Vectorize Queue on page 84

•

Modifying the Entries in the Render Queue on page 88

Changing a Scene's Stage
The Change Stage command allows to change the approval stage name of a selected scene that is in Manual
approval mode. You can also create customized approval stages that reflect the approval process in your
production environment.
A scene's stage is a method of tracking its progress in your production; the scene's current stage doesn't stop
you from advancing the scene to other stages.
Changing a scene's stage and making manual approvals allows you to assign and change a scene's approval
stages to keep track of its current status. For example, if you have a scene whose drawings are being scanned,
you'll mark it as the Scan stage. After you begin adding colour to these line drawings, you can change the
scene's stage to Paint.

If the selected scene has an automatic approval policy, the Change Stage command will be inactive
in the Scene menu. In order to change a scene's stage, you must ensure that the approval policy is
set to Manual.

To change a scene's stage status:
1. In the Scenes section, select a scene.
2. In the top menu, select Scene > Change Stage. You can also right-click anywhere in the Scenes list and
select Change Stage.
The Change Scene Stage dialog box appears.
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The current stage of the selected scene appears in the From Stage field.
3. Select the stage you want to apply to the current scene from the To Stage drop-down menu.
4. Click on the OK button.

Related Topics
•

Updating Scenes on page 37

Changing the Sequence of Scenes
You can change the sequence of scenes in your job, which affects the order in which the scenes appear in the job
throughout the system. You can place a scene anywhere in the Scenes list or you can sort them alphanumerically.
To re-sequence a scene, follow these steps:
1. Select the job whose scenes you want to re-sequence from the Jobs panel.
2. In the top menu, select Scene > Reorder. You can also right-click anywhere in the Scenes list and select
Reorder.
The Reorder Scenes dialog box appears.

3. Select the reordering method by clicking on the column headers or dragging the scenes up or down.
4. Once the scenes are ordered, click the OK button to accept the new order or click Cancel to abort the resequencing.

Related Topics
•

Updating Scenes on page 37
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Clearing Scenes from Control Center
If you must restart a scene from scratch, you can completely erase a scene's exposure sheet. When you clear a
scene, you delete all exposure sheet database information and reset the scene as if it were completely new.
When you clear a scene, you are only deleting the files from the database; the Control Center module does not
actually delete any image files (drawings, scan, final frames). If you have questions concerning the contents of a
scene, you should contact the technical director responsible for the scene in question.

If you must clear a scene from the Control Center module, make sure no one else is currently using
the scene's data. If you clear a scene that someone else is working on at that moment, you run the
risk of corrupting the files and losing work.
If you must clear a scene, you should wait until everyone is offline to ensure that no one can open
the data files while you clear them from the Control Center module.

To clear a scene:
1. Select the environment, the job, and the scene you want to clear.
2. In the top menu, select Scene > Clear. You can also right-click anywhere in the Scenes list and select
Clear.
The Confirm dialog box appears.

‣

Click OK to clear the data from the scene.

‣

Click Cancel to cancel the clear command.

The Scene list refreshes itself and displays blank elements and drawings lists, showing that the Control Center
module has deleted the exposure sheet for the scene you cleared.

Related Topics
•

Updating Scenes on page 37

Copying an Exposure Sheet to Another Scene
When you have two scenes with similar exposure sheet information, instead of entering the information twice,
you can:
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1. Enter the information for one exposure sheet.
2. Copy it to the other scene.
3. Modify the second exposure sheet as needed.
The Copy command lets you copy an existing exposure sheet from one scene into another scene. You can then
modify the copied exposure sheet using Stage.
To copy an exposure sheet to another scene:
1. Select the environment and the job from the Control Center window.
2. In the top menu, select Scene > Copy You can also right-click anywhere in the Scenes list and select
Copy.
The Copy Scene dialog box appears.

3. Select the environment, job, and scene to copy from the exposure sheet from the From panel.
The lower half of the dialog box displays the Environments, Jobs, and scenes to which you can copy the
exposure sheet.
4. Select the Environment, Job, and scene where you want to copy the selected exposure sheet to the To
panel.
5. If you want to copy the associated animation data files with the scene's exposure sheet, select the Copy
All Data Files option. Harmony will place a copy of the animation data in the target scene's storage
directory.
6. Click OK or Apply to complete the copy or click Close to abort the copy command.
7. If the scene you are copying to already has an exposure sheet, a Confirm dialog box appears to make sure
you want to replace the existing exposure sheet.
‣

Click Yes if you want to copy over the existing exposure sheet.

‣

Click No to cancel the copy or to select a different scene.

The Copy Xsheet dialog box disappears. You can view and modify the copied exposure sheet using Harmony
Stage.

Related Topics
•

Clearing Scenes from Control Center on the previous page
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Send Scenes to the Render Queue
When you are ready to send a set of scenes for rendering, you can use the Send to Rendering command. This
command allows you to send one or more scenes for rendering to the Batch Processing machine.
You can also use Harmony Stageto render scenes, but since you must open each scene individually in Harmony
Stage, you can only send one scene to render at a time.
To send a group of scenes to the render queues:
1. In the Control Center window, select the Environment, Job and scenes that you want to send to the
Render queue for rendering.
2. In the top menu, select Scene > Send to Rendering. You can also right-click anywhere in the Scenes list
and select Send to Rendering.
The Render Network dialog box appears.

3. Select the frames you want to render:
‣

All Frames: sends all the frames in the scene to be rendered.

‣

Selected Frames: sends a range of frames to be rendered. You can only send a range of frames if you
selected one scene.

4. Select the Chunk Size checkbox if you want to split the frames into sets of frames. Enter the number of
frames you want in each chunk in the Size field.
5. Select the Version of the Scene you want to render.
6. Select the camera you want to use to render the scene's images from the Camera drop-down menu.
These are the cameras you created in your exposure sheet in Harmony Stage.
7. If you want to create a Field Composite, select the checkbox to refine your selection.
‣

Select the Add Pulldown checkbox to use the 3:2 pulldown technique.

‣

Select the Automatic Combine checkbox to combine even and odd fields on a scene's image.
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•

Select the Second Field First check box to always start with the second field before combining with
the first field.

8. If you did not enable the Batch Composite Options check box, enable the Preview option to see the
render once it is completed.
9. Click OK to complete the render.
To verify that the scenes have been sent for rendering, you can display the Render queue.

Related Topics
•

Viewing the Render Queue on page 86

Deleting a Scene
When you delete a scene, you not only remove the scene from the Control Center window, but you also
permanently remove all the information associated with the scene including:
•

Exposure sheet (and all associated versions)

•

Elements

•

Drawings

•

Database information

•

Any palettes stored in that scene's palette library

Before you delete a scene:
•

Make sure that you really want to remove all this information from the system

•

Are you going to use the scene in the future?

•

Do you need to archive the scene for future use?

•

Make sure no one else is currently using the scene.
failure to do this may result in file corruption and loss of your work.

•

Wait until everyone is offline

•

This ensures no one can open the scene while you delete it.

To delete a scene:
1. Select the scene name you want to delete in the Scenes list.
2. Select Scene > Delete. You can also right-click anywhere in the Scenes list and select Delete.
The Confirm dialog box appears.

‣

Click Yes to delete the scene and all its related information.

‣

Click No to cancel the delete command.

The system deletes the scene name and all its associated files.
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Related Topics
•

Creating a Scene on page 34

Viewing Elements and Drawings
You must use the Harmony Stageor Harmony Xsheet, rather than Control Center, to add elements or drawings
to your environment. After you add them in the exposure sheet and save the source, the Control Center module
displays them in the Elements and Drawings panels.

When you select a scene in the Scenes list, all of the elements associated with the scene (e.g. background,
characters, etc.) appear in the Elements and Drawings lists. The Control Center module retrieves these
components from information you previously entered in the exposure sheet.
You can click on the Expand/Collapse

buttons to show or hide the Elements and Drawings sections.

Related Topics
•

Managing Environments, Jobs and Scenes on page 24
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Exporting and Importing Data
This section explains how to import and export data with Harmony.
You can use the Control Center module's export utility to migrate scenes from your system for archival purposes
or third parties, and you can use the import utility to integrate scenes into an Harmony environment.

Related Topics
•

Exporting Data below

•

Importing Data on page 52

Exporting Data
You can use the Control Center module's export utility to copy scene data. After Harmony copies the exported
data to a temporary directory, you can move the archived data to your storage device (for example, a CD or
tape drive).
To select the components you want to export:
1. Launch Control Center.
‣

To learn more about the different launch methods, refer to the Launching Control Center on page 10
section.

2. In the top menu, select Admin > Export.
The Export Scene(s) dialog box appears.
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3. Enter the path where you want to export the files. You can also use the Browse button to select this path
and create a folder. The destination must be an existing empty folder or a new folder that will be created
during the export process.
4. Click Add to select the scenes that you want to export from the Harmony database. You can select a Job
to select all scenes in a job. The scenes you select will appear in the list.
5. Select one or more scenes and click Remove to remove scenes from the export list.
6. In the Data Options tab, select what you want to export:
‣

Audio: Exports the Audio directory.

‣

Database: Selected by default, this option exports the elements in the scene. If you select this option
and de-select the Elements option, you will be able to access the elements from the Element
Manager in the Control Center, but their drawing and bitmap files will not be included. Also exports
the list of available versions in the scene. It will not be possible to open a scene if this is not selected
for export.

‣

Final Frames: Exports the directory that contains final, rendered frames.

‣

Other Directories: Exports all other directories and files in the scene's data structure.

‣

Elements: selected by default, this option exports the contents (drawing and bitmap files) of the
Element directories.

‣

Timing Drawings: Selected by default, this option exports the contents of the Timing directories.
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‣

Annotation: This option allows you to export the different drawings created while drawing in
annotation columns and imported images.

‣

Stage (xsheet and network): Selected by default, this option exports the Stage directory, which
contains the STAGE files for each scene you export. These files are necessary if you want to be able to
re-use the exposure sheet (timing) and the effects network from the original scene.

If this option is selected, you can select the Get Outside Drawings option to copy drawings into the scene
folder that are referred to by Timing columns and their Element (Drawing) modules.
‣

Palettes: Exports the palette-library directories. When you select this option, you must decide if
you want to export the palette-library from the Environment, Job or scene level. When you
select a level, the palette-library in lower-level directories will also be exported.

‣

Macros: Exports the Macros (customized effect and module connections) that were created and
stored in the environment, jobs or scenes to be exported.

‣

Libraries: Exports Templates created at the selected levels.

7. In the Advanced Options tab (Mac OS X and Linux), select how you want to package the exported scene.
The choices you make here are related to the size of the export package as well as the speed of the
export process.
Due to constraints in the Windows operating system, you do not have any choices on the Advanced
Options tab. In Linux, you can make the following selections.
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‣

Select one of the following options in the Exporting Files section:

•

As hard links if possible, otherwise copy: Speed up the export process by making hard links to the
original files on the file system. Hard links keep disk space usage to a minimum and ensure a quick
export process.

If it is not possible to create hard links (because the links cross file systems, for example), the entire
contents will be copied to the destination directory, which will be a slower process that will take up more
space on your file system.
•

As hard links when possible, otherwise symbolic links: Ensures a quicker export process. However,
if symbolic links are used and the original file is deleted, the symbolic link will be broken.

•

As symbolic links: Export the scene using symbolic links to the original scene files (when importing,
imports the scene using symbolic links to the export directory). While this process will reduce the size
of the export directory, if the original file is deleted, the symbolic link will be broken.

•

Copy: Copy all scene data to the export location. This produces the largest export package and
therefore takes the longest to complete. However, it is the simplest method.

‣

Select one of the following options in the Valid Links Options panel:

•

Keep them: Maintain symbolic links.

•

Resolve them: Remove symbolic links, replacing them with the actual files. When you use this option,
the export package will contain real files, rather than symbolic links.

•

Ignore them: Do not include valid symbolic links in the export package.

‣

Select one of the following options in the Broken Links Options panel:

•

Keep them: Keep symbolic links to missing files. When the missing files are placed in the path
searched by the symbolic link, broken links will be valid again.

•

Ignore them: Do not include broken symbolic links in the export package.

8. Click on the Calculate button to get a preview of the size of your export package.
9. Click Export. The system exports the selected files and components. Use the Message Log tab to view
messages generated during the export process.
Unlike Windows, where the database information and the scene data have been copied to a different directory,
Linux creates a set of links to the data.
You must use additional Linux commands to retrieve the animation data pointed to by the links.

50

Toon Boom Harmony 10.3 Control Center and Server Guide

Harmony creates two files during the export process:
•

README.txt file (includes export statistics, such as creation date and user ID)

•

IEContents.dat file (includes export parameters)

Related Topics
•

Exporting the Data in Linux below

•

Exporting and Importing Data on page 47

Exporting the Data in Linux
In Linux, exporting your scenes using the Export command makes Harmony copy scene information and link
information to the temporary export directory you selected.
Therefore, you must retrieve the animation data from your server and copy it, along with the database
information, to your storage device.

You can compress the export package to make it transportable. However, it will resolve hard links and
symbolic links, which might be contrary to your export options.

Copying the exported data to a storage device is a two-fold process. Copy the exported animation files to a file
on the storage device. Then remove the temporary export data from your system.
To export your files to a storage device:
1. Open a Linux shell and log in to the machine that connects to the storage device.
2. Copy the exported files using links from the source directory to the selected destination file. To export to
a file on a storage device, type the following command in a shell:
tb_backup_export_data -from [source_directory] -to [destination_file] â writetarfile

‣

Where [source_directory] is the folder where the scene was exported to.

‣

Where [destination_file] is the file that will be created by the tb_ backup_export_data script.

3. After a successful copy of the exported data, remove the temporary export directory using the following
command:
tb_remove_export_data [export_directory]

‣

Where [export_directory] is the folder where the scene was temporarily exported to before it was
copied to the file or storage device.

Related Topics
•

Exporting and Importing Data on page 47
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Importing Data
If the imported files are compressed, you must decompress them to a temporary directory before you
can import them into Harmony. If you don't know how to decompress these files, see your system
administrator.

To import files into the Control Center module:
1. Select Admin > Import. The Import Scene(s) dialog box appears.

2. Any supported Stage file can be imported, including IEContents.dat files. The IEContents.dat file
includes database and scene file information. Specify the path of IEContents.dat for the scene(s) you
want to import.
3. Click the Browse button to select the environment, job and file system where you want to place the
imported scene.
4. If you want to import only some of the scenes in the Scenes to Import list box, select the scenes.
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If no scenes are selected, all scenes will be imported.

5. In the Data Options tab, select what you want to import (the selections steps 5, 6, and 7 are described in
the corresponding steps of the export procedure in the section, Exporting Data on page 47).
6. In the Advanced Options tab, select how you want to import the scene. Select one of the option each in
the Valid Links Options and the Broken Links Options panels.
7. Click on the Import button.
If the scene already exists, the Scene Exists dialog appears. Click either Import Scene for each scene or
Import All Scenes to confirm your selection.
Use the Message Log tab to view messages generated during the import process.

If the name of the scene you are importing in Control Center is too long, you will be prompted with
an error message stating that it will be truncated. A scene's name cannot exceed 23 characters.

If you are importing scenes that were exported from the Harmony Network, or worked-on in
Harmony Stand-alone, the system will try to retrieve the version name.

Related Topics
•

Exporting and Importing Data on page 47

Troubleshooting
If you have any problems exporting or importing in Harmony, review the instructions to make sure you have
followed them completely. If you continue to have problems, consult the following list to troubleshoot common
import and export problems.
•

Problem: Import or Export Not Successful
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If the transfer is not successful, an error dialog box appears to describe the problem. The most common
reason for a failed transfer is due to your current network permissions. See your system administrator for
help.
If the transfer fails in the middle of the process, the files that were imported or exported may be corrupt
or incomplete.
•

For a failed import, use Control Center to delete the scene.

•

For a failed export, manually delete the incomplete export folder.

If you click the Message Log tab, you can see more detailed descriptions, including error messages.

Related Topics
•

Exporting and Importing Data on page 47
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Control Center Commands
This section describes all the commands in the Control Center window.

Control Center Commands
Use the Control Center menu to access the About information and quit the application on Mac OS X.
Command

Action

Access Methods

About Toon
Boom
Harmony

If you are using Mac OS X, use the
About command to display product,
version, licensing and copyright
information.

Quit

If you are using Mac OS X, use the
Quit command to close the Control
Center window and end the current
session.

Press [⌘ ] + [Q], the default
keyboard shortcut.

File Commands
Use the File menu to access the Log file and exit the application on Windows/Linux.
Command

Action

Access Methods

Exit

If you are using Windows/Linux, use
the Exit command to close the
Control Center window and end the
current session.

Press [Ctrl] + [Q], the default
keyboard shortcut

View Log

Use the View Log command to
open the dialog box, so you can
view errors and warning messages
related to your actions during the
current Control Center session.

Environment Commands
Use the Environment menu to manage the environments and queues.
Command

Action

Access Methods

Change
Asset Lock

Use the Change Asset Lock
command to enable or disable the
automatic Global Lock on the
scenes under the selected

Right-click on the selected
environment in the Environments
list and select Change Asset Lock.
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Command

Job Commands

Action

Access Methods

Environment.
Create

Use the Create command to open a
Create Environment dialog box,
where you can give a name to a new
environment.

Right-click the Environments list
and select Create.

Delete

Use the Delete command to delete
an environment from the database.
You cannot delete an environment
unless it is empty; delete all of the
environment's scenes and jobs
before activating this command.

Right-click the Environments list
and select Delete.

Render
Queue

Use the Render Queue command
to open the Render Queue dialog
box and monitor and prioritize the
progress of the drawings that the
system is rendering.

Right-click the Environments list
and select Render Queue.

Vectorize
Queue

Use the Vectorize Queue command
to open the Vectorize Queue
dialog box where you can display
the progress and prioritize the
drawings that the system is
converting to the TVG vector file
format.

Right-click the Environments list
and select Vectorize Queue.

Job Commands
Use the Job Menu to manage the jobs and their state.

Command

Action

Access Methods

Change Priority Use the Change Priority command to
open the Choose New Priority dialog
box and set the priority of the
rendering and vectorizing tasks for one
or more jobs. The priority is set using a
sliding scale where 0 is the highest
priority and 10 is the lowest.

Right-click the Jobs list and select
Change Priority.

Change Stage

Right-click the Jobs list and select
Change Stage.

Use the Change Stage command to
open the Change Stage of Jobs dialog
box and record the current stage of the
environment's jobs in the production
process. You can change the job from
In Production to Completed, or from
Completed back to In Production,
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Command

Action

Access Methods

should you need to perform further
work.
Create

Use the Create command to open the
Create Job dialog box and add a new
job to the selected environment.

Right-click the Environments list and
select Create.

Your job must have a name that is
unique to the animation database (for
example, you cannot have two jobs
with the same name. Even if they exist
in different environments, they are all in
the same database).
Delete

Use the Delete command to remove a
job from the selected environment.

Right-click the Jobs list and select
Delete.

When a job is deleted, its scenes,
elements, drawings, palette library and
database information are permanently
removed. If you want to archive a job,
you should only delete the job after you
have used the command to create the
archive.
Before you activate this command,
verify that the selected jobs are not
currently in use.

Scene Commands
Use the Scene menu to manage the scenes.
Command

Action

Access Methods

Change
Priority

Use the Change Priority command
to open the Choose New Priority
dialog box and set the priority of
the rendering and vectorizing tasks
for one or more scenes. The priority
is set using a sliding scale where 0 is
the highest priority and 10 is the
lowest.

Right-click the Scenes list and select
Change Priority.

Activating this command affects all
subsequent scenes you create.
Change the priority of a scene that
has already been sent to batch
processing queue by using the
Change Priority button in the
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Command

Scene Commands

Action

Access Methods

queue.
Change
Stage

Use the Change Stage command to
open the Change Scene Stage
dialog box and record the current
stage of progress a scene in an
environment or in a production.

Right-click the Scenes list and select
Change Stage.

This command is inactive if the
scene's approval policy has been set
to Manual in the Change Approval
Policy dialog box.
Clear

Right-click the Scenes list and select
Clear.

Use the Clear command to delete a
scene's exposure sheet. Only
exposure sheet files are deleted
from the database: image files will
not be deleted.
A delete confirmation message
appears, detailing the consequences
of using this option and requests
that you contact your Technical
Director if you are unclear about this
procedure.
Before you activate this command,
ensure that all users are logged out
of Toon Boom Harmony and that no
files are currently in use.

Copy Scene

Use the Copy Scene command to
open the Copy Scene dialog box
and copy one scene's exposure
sheet into another scene. You can
select a source and destination
Scene in which to copy the Xsheet
data.

Right-click the Scenes list and select
Copy.

Create

Use the Create command to open
the Create Scene dialog box and
add one or more scenes to the
selected job. You can also choose
to:

Right-click the Scenes list and select
Create.

Add a scene from another file
system and add it to your job.
Choose the position the scene will
take within your job.
Delete

Use the Delete command to remove
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Command

Action

Access Methods

a scene from the database. Before
you activate this command, ensure
that all users are logged out of Toon
Boom Harmony and that no files are
currently in use.
When a scene is deleted, its
exposure sheet, elements,
drawings, palette library and
database information are
permanently removed. If you want
to archive a scene, you should only
delete the scene after you have used
the command to create the archive.
Before you activate this command,
verify that the selected scenes are
not currently in use.
Force
Unlock

Use the Force Unlock command to
unlock a scene that has been locked
in Harmony Stage. Generally, a
scene unlocks when it is closed by a
user, however if a computer crashes
while a scene is locked and in use, a
scene may remained locked even if it
is not open.

Right-click the Scenes list and select
Force Unlock.

An unlock confirmation message
appears detailing the consequences
of using this option.
If you activated this command for
more than one scene, you will be
prompted for confirmation to
unlock each scene separately.
Force
Unlock
Version

Use the Force Unlock Version
command to unlock a version of a
scene that has been locked by
Harmony Stage. Generally, a scene
unlocks when it is closed by a user,
however if a computer crashes while
a scene is locked and in use, a scene
may remained locked even if it is not
open.
An unlock confirmation message
appears detailing the consequences
of using this option.
If you activated this command for
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Command

Scene Commands

Action

Access Methods

more than one scene, you will be
prompted for confirmation to
unlock each scene separately.
Move

Use the Move command to open
the Move Scene dialog box and
move one or more scenes and their
associated files to a file location of
your choice. The Move Scene
command allows you to select one
or more scenes and to calculate the
amount of space you will need at the
new location to accommodate the
moved scene.

Right-click the Scenes list and select
Move.

Before you activate this command,
ensure that all users are logged out
of Toon Boom Harmony and that no
files are currently in use.
Rename

Use the Rename command to open
the Rename Scene dialog box and
enter a new name for the selected
scene. Before you activate this
command, verify that no users are
using the scene. It is recommended
that all users are logged out of Toon
Boom Harmony and that no files are
currently in use to ensure the safety
of your files

Right-click the Scenes list and select
Rename.

Reorder

Use the Reorder command to open
the Reorder Scenes dialog box and
change the sequence of the scenes
in a job.

Right-click the Scenes list and select
Reorder.

Send to
Rendering

Use the Send to Rendering
command to open the Composite
dialog box and add one or more
scenes to the rendering queue.

Right-click the Scenes list and select
Send to Rendering.

Send to
Unvectorize

Use the Send to Unvectorize
command to open the Send Scenes
to Unvectorize dialog box and
convert a scene's vector drawings
into bitmap drawings.

Right-click the Scenes list and select
Send to Unvectorize.

Send to
Vectorize

Use the Send to Vectorize
command to convert the selected
drawings to the TVG vector file
format.

Right-click the Scenes list and select
Send to Vectorize.
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Element Commands
Use the Element Menu to vectorize and unvectorize the elements.
Command

Action

Access Methods

Send to
Unvectorize

Use the Send to Unvectorize
command to open the Send
Elements to Unvectorize dialog
box and convert an element's vector
drawings into bitmap drawings.

Right-click the Elements list and
select Send to Unvectorize.

Send to
Vectorize

Use the Send to Vectorize
command to convert the drawings
for the selected elements to the
TVG vector file format.

Right-click the Elements list and
select Send to Vectorize.

Drawing Commands
Use the Drawing Menu to vectorize and unvectorize the drawings.
Command

Action

Access Methods

Send to
Unvectorize

Use the Send to Unvectorize
command to open the Send
Drawings to Unvectorize dialog
box and convert selected vector
drawings into bitmap drawings.

Right-click the Drawings list and
select Send to Unvectorize.

Send to
Vectorize

Use the Send to Vectorize
command to vectorize the selected
drawings.

Right-click the Drawings list and
select Send to Vectorize.

Admin Commands
Use the Admin Menu to import and export scenes, manage the users and the approval policy.
Command

Action

Access Methods

Change
Approval
Policy

Use the Change Approval Policy
command to open the Change
Approval Policy dialog box and
select a manual or automatic
approval of the production status at
each stage of each scene.

Export

Use the Export command to open
the Export Scenes dialog box and
transfer copied data from the
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Command

Help Commands

Action

Access Methods

database to a different directory.
You can also export scenes to Stage
(offline version) by selecting the
Export Offline.
Import

Use the Import command to open
the Import Scenes dialog box and
transfer copied data from another
directory into the database.

Users

Use the Users command to open
the User List dialog box to display
all valid Toon Boom Harmony users
in the network. You can add to,
delete from or modify this list.

Vectorize
Style

Use the Vectorize Style command
to open the Vectorization Styles
dialog and select the vectorization
style you want to apply to drawings
before sending them to the
Vectorization Queue.

Help Commands
Use the Help Menu to access the Help files and Control Center About information when using Windows/Linux.
Command

Action

Access Methods

Help

Use the Help command to view the
Control Center integrated help
system.

Press [F1], the default keyboard
shortcut.

About

If you are using Windows/Linux, use
the About command to display
product, version, licensing and
copyright information.
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Chapter 1: Batch Processing
The Toon Boom Harmony system uses batch processing to either convert scanned drawings to a vector-based
format or to render the final animation. The system performs these tasks in the background; you won't even
realize the system is performing the tasks.
There are two types of batch processes in Harmony. Both types of batch processes can run on almost any
computer on the network:
•

Vectorize: This process prepares the images scanned on the black and white scanner for painting by
converting them to vector based files (*.tvg files). The vectorizing process converts the drawings from a
bitmap format to a digital line-based format.
Vectorizing prepares images for painting by creating paint files. You would only have to manually send
scenes to be vectorized in special cases such as:
•

Processing images that were not scanned in the Scan module

•

Reprocessing a scene due to unrecoverable painter errors

•

Completing the vectorization after you run the scene through a pencil test

You can open the Vectorize Queue in the Control Center module for the list of vectorizing work waiting
to be processed by a Vectorizing machine.
•

Render (also known as Compositing): This process composites scenes, creating the final frames.
When you have finished working on a scene or all of your animated sequences, you can render it out locally
or send it to the Render Queue. After you render your animation, you can transfer the scenes to video or
film.
You can open the Render Queue in the Control Center module for the list of compositing work waiting
to be processed by a rendering machine.

When you create a new environment for a project, you must setup the batch processing. You can create a
particular batch processing schedule and assign certain machines on your Harmony network to render and
vectorize the scenes in that Environment.
You must set up batch processing on selected Harmony machines to convert scanned drawings to vector files
and to composite final frames.

We do not recommend rendering/vectorizing on the workstation while you are working in the
software. These tasks are resource intensive and will slow your computer down if you are trying to
work in the software at the same time. If urgently needed on a continual basis, set up a separate
render station to do this. Otherwise, batch processing should be done while the workstation is
inactive.

With Harmony batch processing, you can spread the workload across multiple computers on the network,
creating a render farm.
To create a render farm, you have to identify all of the computers that will be processing Harmony files and you
have to start the batch processing queues. Then, you have to set up all Environments you add to the database
for batch processing.
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Once you have set up batch processing, you can send your drawings to be vectorized and send the scenes to be
rendered. This chapter also explains how to view the vectorize and render queue to check on how the batch
processing is progressing.

Topics Covered
•

Installing Batch Processing and Configuring the machine-list File (Windows) on the facing page

•

Creating the machine-list File (Linux) on page 68

•

Installing Batch Processing and Configuring the machine-list File (Mac OS X) on page 69

•

The tbprocess Program on page 72

•

Setting Up Default Schedules on page 79

•

Testing Batch Processing on page 81

•

Troubleshooting on page 92

•

Advanced Batch Processing on page 95

•

Vectorizing Scenes or Elements on page 82

•

Rendering Your Scenes on page 86

•

Stopping a Process on page 89
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Installing Batch Processing and Configuring
the machine-list File (Windows)
The machine-list file identifies all of the machines on your network that can be allowed to batch process
Harmony files. The machines on this list represent the render farm.
You must have sufficient batch processing licenses to run batch processing on all of the machines in the
machine-list file.
In Windows, use the Harmony Configuration Wizard to add computers to the machine-list file and to install the
batch processing service. You must run the configuration wizard on all machines that will perform batch
processing.
To launch the Harmony Configuration Wizard:
‣

On Windows: Click the Start menu and select All Programs > Toon Boom Harmony 10.3 > Tools >
Configuration Wizard.

The Toon Boom Harmony Configuration window opens.

To configure batch processing:
1. In the Wizards section, click the Batch Processing button.

2. In the next window, you are asked if this machine will do batch processing. Select Yes.
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3. Click on the Next button.
4. In the What is the Name of the Server field, enter the name of the Harmony server.

5. In the What is the User field, type the server's username (OS account) created while setting up the
Harmony database. The machine you are setting up will use this username and password to log on the
server machine and retrieve the data to render or vectorize.
6. In the What is the Password field, type the password corresponding to the selected username.
7. Click on the Next button.
8. The Harmony Configuration wizard presents a review of all the changes that it will make.
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9. Click on the Finish button to complete the process.
10. A dialog box appears to indicate if the configuration process has been successful.

Related Topics
•

Creating the machine-list File (Linux) on the next page

•

Installing Batch Processing and Configuring the machine-list File (Mac OS X) on page 69
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Creating the machine-list File (Linux)
The machine-list file identifies all of the machines on your network that can be allowed to batch process
Harmony files. The machines on this list represent the render farm.
You must have sufficient batch processing licenses to run batch processing on all of the machines in the
machine-list file.
To create the machine-list file on Linux:
1. Using a text editor, create a new text file. Enter all of the machine names in your render farm in this file.
The order that you list machine names in this list determines their order in the batch processing
scheduling commands.

There must be no blank lines in the machine-list file.

For example, your machine-list might look like this:
anim-1
anim-2
anim-3
bart-1
bart-2
paint-1
paint-2
paint-3
Your machine name is created when you install Linux. You can list the machine name of a computer by
typing the following command in a terminal or command prompt:
uname -n
2. Save the file with the name machine-list in the /USA_DB/schedules/ directory.

Related Topics
•

Installing Batch Processing and Configuring the machine-list File (Mac OS X) on the facing page

•

Installing Batch Processing and Configuring the machine-list File (Windows) on page 65
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Installing Batch Processing and Configuring
the machine-list File (Mac OS X)
On Mac OS X, use the Configuration Assistant to install the batch processing queue Startup Item that will start
the batch processing service. You must run the Configuration Assistant on all machines that will perform batch
processing.
To install the batch processing queue Startup Item:
1. In the Finder, go to Applications > Toon Boom Harmony 10.3 > Tools > Configuration Assistant.
2. Select the Create the Startup Items option and click the Continue button.

3. Select the Create Queue Server Startup Item and click the Create button.

The Authenticate dialog box appears asking for a user name and a password.

4. Type a user name that is allowed to administer this computer then click the OK button.
This will copy the files necessary to automatically start the batch processing queue on the counter.
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5. Repeat these steps on all the computers that will be doing batch processing.
The files required to start the batch processing queue are copied by the Configuration Assistant in:
/Library/StartupItems/ToonBoomQueueServer/ folder.
A dialog box appears to indicate if the Startup Item was successfully created.

6. Click the OK button to close this dialog.
The Finish window appears.

7. Click the Done button to close the Configuration Assistant.

Related Topics
•

Machine-list File below

•

Installing Batch Processing and Configuring the machine-list File (Windows) on page 65

•

Creating the machine-list File (Linux) on page 68

Machine-list File
The machine-list file identifies all of the machines on your network that can be allowed to batch process Harmony
files. The machines in this list represent the render farm. You must have sufficient batch processing licenses to
run batch processing on all of the machines in the machine-list file.
To create the machine-list file:
1. In a text editor, create a new text file.
2. In the new text file, enter all of the machine names in your render farm in this file.
The order that you list machine names in this list determines their order in the batch processing
scheduling commands.
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There must be no blank lines in the machine-list file.

For example, your machine-list might look like this:
anim-1
anim-2
anim-3
bart-1
bart-2
paint-1
paint-2
paint-3
‣

Your machine name is created when you install Mac OS X. You can list the machine name of a computer
by typing the following command in a terminal or command prompt:
hostname

3. Save the file with the name machine-list in the /USA_DB/schedules/ directory.

Related Topics
•

Installing Batch Processing and Configuring the machine-list File (Mac OS X) on page 69
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The tbprocess Program
The tbprocess program monitors the database queues for batch processing work to be done. When if finds a
batch processing Job to complete, it launches the appropriate Vectorize or Render programs to process the Job
(you can monitor these Jobs using the Queues in the Control Center module). In order for a machine to perform
the batch processing, you must launch the tbprocess program on it.
You can use a set of schedules to better manage the batch processing on your Harmony system. While
Scheduling dictates the type and time a machine will perform batch processing, the tbprocess program does the
actual batch processing work (for both Vectorize and Render batch processing).
There are several ways in which you can start tbprocess on a machine and then verify that it is indeed running.
You can run only one session of tbprocess per machine. If you try to run more than one tbprocess session,
nothing happens (the first tbprocess session keeps running). You can monitor the Jobs taking place in the
tbprocess session by opening the log file.

Remember that just because tbprocess is running on a machine, it does not mean that the machine
is actually doing any batch process work at that moment.
The schedules determine the location and the time when the machines perform batch processing
work.

Related Topics
•

Starting the Batch Processing Queue on Windows below

•

Starting the Batch Processing Queue on Linux on page 74

•

Starting the Batch Processing Queue on Mac OS X on page 75

•

Verifying that a tbprocess Session is Active on page 76

•

Monitoring a tbprocess Session on page 77

Starting the Batch Processing Queue on Windows
When you launch a Harmony module, there are functions that applications perform in the background that you
generally don't see. Two of these functions are as follows:
•

tbprocess: manages requests for batch processing of vectorized drawings or rendered scenes.
When you ran the Harmony Configuration Wizard, you had the option of having batch processing on
your system. If you selected the Yes option and you have a valid license, the tbprocess starter is ready to
run; otherwise, you won't be able to perform batch processing on Harmony.

•

tbdbserver: when you have a Server/Standalone configuration, the tbdbserver controls the entries that
you make to the Harmony database (like adding new scenes to a Job).
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When you run the Toon Boom Harmony Configuration Wizard, it automatically configures your
system to launch the tbdbserver, so you don't need to configure anything else.

To modify the Process Starter launch properties, follow these steps:
1. From the Windows Start menu, select Control Panel from the Settings sub-menu.
The Control Panel window appears.
2. Double-click the Toon Boom Harmony Control Panel icon

in the Control Panel window.

TheToon Boom Harmony Control Panel dialog box appears.
3. Click the Process Starters tab. You can use this tab to select a specific process starter and to see its
parameters

The Process Starters tab displays the following information:
‣

User: Displays the profile that the process starter uses by default.

‣

Password: Displays the password for the user specified in the User field.

‣

Command Line: Displays the path of the application you want process starter to launch.

‣

Log File: Displays the name of the log file that records all the messages from the application named in
the Command Line field.

‣

Working Directory: Displays the path that contains all the applications you need and where these
applications can store data while they run.

4. Make any modifications you need to the existing services and click on the Update parameters button.
5. Click OK when done.

Related Topics
•

Starting the Batch Processing Queue on Mac OS X on page 75

•

Starting the Batch Processing Queue on Linux on the next page
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Starting the Batch Processing Queue on Linux
After the machine-list file is created, you are ready to start the batch processing queues. You must start the
batch processing queues on all machines that will batch process.
To start batch processing queues:
‣

Type the following in a terminal or command prompt:
/sbin/service USAnimation_queues start

A message will appear in the shell indicating that the script has been successful.
The tbprocess program is installed with the Toon Boom Harmony system. It monitors the Vectorize and Render
batch processing queues for work to be done and runs the appropriate programs to vectorize or render the
images.
If you reboot your machine after you install the Toon Boom Harmony, the tbprocess program starts
automatically on each Toon Boom Harmony client and server.

During a normal installation, Harmony places a file called S98USAnimation_queues in the
/etc/rc2.d/ folder. This file controls the launching of the tbprocess program when you reboot.
This file name S98USAnimation_queues may change and the first two numbers at the beginning
of the file name could be:
S97USAnimation_queues,S96USAnimation_queues, S95USAnimation_queues and so on.
If you don't see this file in the /etc/rc2.d/ folder, you need to reinstall the links for Harmony.
However, if you don't reboot after you install the Toon Boom Harmony system, or someone stops the
tbprocess program on a specific machine, you must launch the tbprocess program on each machine
assigned to the batch processing schedule before you can batch process the items in the Vectorize
or Render queues.

To launch the tbprocess program on a batch processing machine, follow these steps:
1. Open a command prompt and log in as the root user on the machine you want to start the Process
program.
2. Type /etc/init.d/USAnimation_queues stop and press [Enter] just to make sure that there are
no tbprocess programs already running.
3. Type /etc/init.d/USAnimation_queues start and press [Enter]. A PID (Process ID) number
appears when the tbpprocess starts.
[1] 19003
If you want to stop the Process program on a machine, you would type /etc/init.d/USAnimation_
queues stop and press [Enter].
4. To view the batch processing schedule status for all machines, type Status and press [Enter].
The batch processing schedule appears.
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The column on the left displays an R for each machine on which you launched the tbprocess program.

Starting the Batch Processing Queue on Mac OS X
After the machine-list has been created and that the Startup Item has been installed you are ready to start the
batch processing queue.
The Startup Item will start the batch processing queue automatically every time the computer is started, but you
can start it without restarting the computer by doing the following:
To start batch processing queues:
1. Open the Mac OS X Terminal application. Go to Applications > Utilities > and double click the Terminal.
2. Type the following in the Terminal:
sudo /sbin/SystemStarter start ToonBoomQueueServer
The Terminal prompt you to type your password. Your user needs to be allowed to administer this
computer for this command to work.
To stop batch processing queues:

‣ Type the following in the Terminal:
sudo /sbin/SystemStarter stop ToonBoomQueueServer
The Terminal will prompt you to type your password. Your user needs to be allowed to administer this
computer for this command to work.
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Verifying that a tbprocess Session is Active
There are two commands you can use to verify that tbprocess is running on a machine. To use any of these
commands, type the one you want to use in a Command Shell or Terminal and press [Enter].
•

Status command
This command allows you to view the Schedule Status (see Displaying the Schedule Status on page 96). If
tbprocess is running on a machine, an R appears in the R column for that machine.

On Linux
•

ps –f –u usabatch | grep roc command
This command verifies if you have a tbprocess session running on a machine.
•

–f produces a fully-detailed list of information

•

–u usabatch lists only information by the user usabatch.

Since more than one user can start the tbprocess program, you can view a more complete list by
removing the -u usabatch parameter from the command. You can also replace this parameter by –efa to
view all the processes on the machine, regardless of the user (except the processes that are not linked to
an Command shell).
•

-grep roc searches for commands that contain the letters “roc”. This allows you to search for
Process sessions only.

A list of all the processes running for usabatch appears:

On Mac OS X
•

ps -axc | grep roc command
This command verifies if you have a tbprocess session running on a machine.
•

-a displays information about other users' processes as well as your own.

•

-x displays information about processes without controlling terminals.

•

-c changes the "command" column output to just contain the executable name, rather than the full
command line.

A list of all the processes running appears:

The ps command is a Linuxstatement used to report active processes. There are a variety of options and
arguments that you can run with this command to limit or alter the information that appears. The arguments
used with the ps command in this document are only suggestions. Refer to your Linux manuals for more
information on the different options and arguments available with the ps command.
On Windows
In Windows, the process can be verified from:
•

Toon Boom Harmony Control Panel: Control Panel > Toon Boom Harmony Control Panel

•

Services panel: Control Panel > Administrative Tools > Services panel
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Monitoring a tbprocess Session
As the tbprocess program batch processes the Jobs, you can see which Jobs it is processing and which ones are
waiting in the queue. This is handy in case you want to remove old Jobs from the queue because you made
changes to them, or if you want to change the processing priority in the jobs.
There are two ways to monitor the tbprocess session:
•

Using the Queue windows in the Control Center module.
The easiest way to monitor a tbprocess session on a particular machine is to open the Render or
Vectorize queues using the Control Center module.

•

Typing the ssh and tail commands in a Linux shell.

When checking a machine's Vectorize or Camera queues, remember that if the machine is scheduled to do
processing work for multiple environments, you may need to search both queues in several of the environments
to get a complete picture of what's happening.

Viewing Specific Events in the tbprocess Session in Linux
As the Process session vectorizes your jobs, it stores jobs in a log file. You can find the log files in
/tmp/tbprocess.log file.

Viewing Specific Events in the tbprocess Session in Windows
If you want to check the log on the Windows machines in your network, you must access the machines
themselves and view the tbprocess.log file in a text editor. Some text editors require that you stop the
tbprocess session before you open the log file because it locks the file while recording.

Viewing Specific Events in the tbprocess Session in Mac OS X
As the Process session vectorizes your Jobs, it stores Jobs in a log file. You can find the log files in
/Library/Logs/ToonBoomQueueServer.log file.

Viewing tbprocess Events on One Machine (Linux and Mac OS X)
If you want to view the tbprocess Jobs for a specific machine, you can remotely log into that machine view the
entries in the tbprocess.log file as they get added.
You need to use the two following commands to view these entries:
•

The ssh command allows you to connect remotely to another machine and launch a specified command.
The remote connection stays open for the duration of the command and then closes, ending the
connection.

•

The tail command displays the latest 10 lines of the specified file as they appear.

To view the entries in the tbprocess.log file as they occur, open a shell or a terminal and type:
‣

For Linux type:

ssh machine tail -n -10 -f /tmp/tbprocess.log
‣

For Mac OS X type:
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ssh machine tail -n -10 -f /Library/Logs/ToonBoomQueueServer.log
•

machine is the name of the machine running the tbprocess you want to monitor

•

-n 10 instructs the tail command to display the latest line of the file (you can change this value if you
want)

•

-f instructs the tail command to update the display as the file changes

When using the tail command with the -f option, you must use [Ctrl] + [C] to quit the command.
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Setting Up Default Schedules
When you first set up your Harmony system, it is a good idea to set up a default batch processing schedule. You
can modify this schedule later based on the operating needs of your studio.
If you have not created any Environments, there won't be any environments for you to start up.
You must start up a default schedule for every Environment you create in the Harmony database.

Maintaining a limited number of Environments will make it easier to set up and manage batch
processing queues. For example, you can create four Environments, like test, commercials, and
one Environment per features or series.

To define the default batch processing schedule:
1. Open a command prompt or Terminal.
2. In the command prompt or Terminal, type:
Setdef
Follow the onscreen instructions to set up the Environment for batch processing by selected machines on
the Harmony network.
3. You must enter the machine name on which you want to set up batch processing.
INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all
‣

Type "all" to create a default schedule for all machines in the machine-list or press [Enter] to
create a schedule for only the machine you are currently using.

4. If you enter only one machine name, you must decide if you want to input more machines to process this
Environment.
DO YOU WANT TO INPUT MORE MACHINES
‣

Type "y" and press [Enter] if you want to enter more machines or press [Enter] if you don't want to
enter any more machines.

5. Identify the type of work this machine will be doing, vectorizing, rendering or both.
INPUT TYPE OF WORK ALLOWED is vectorize work allowed
‣

Type "y" if this machine will vectorize drawings.
is camera work allowed

‣

Type "y" if this machine will render scenes.

‣

Identify the environments this machine will process.
INPUT A SET OF DATABASE Environments

‣

Type the number (not the name) for each environment you want to set up on this machine and press
[Enter]. A space (or a comma) must separate each environment number.
should processing of the dbenv's be prioritized
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6. You can prioritize the Environments based on the order you entered them in the previous step. Typically,
you will not want to prioritize environments like this.
‣

Type "n" and press [Enter] if you don't want to prioritize environments.

7. Turn the input on for the machine
input ON or OFF
‣

Press [Enter] to turn the input on.

8. When you are done, a status message appears indicating that the machine is set up for batch processing
using the default schedule.
‣

To view the batch processing schedule status for all machines, type the following in a terminal or
command prompt:
Status

9. Press [Enter] twice to get the report.
The machines that are set up to batch process should appear in the report. There must be an "R" next to
the machine name and the status must be "On" to be able to batch process.
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Testing Batch Processing
To verify that batch processing is working, send a few frames from a scene to be rendered by the Harmony
Stage module.
To test batch processing:
1. Open Control Center and select the environment and job that contains the scene to render.
2. Select the scene, right-click the sample scene in the Scene panel and select Send to Rendering.
The Render Network dialog box opens.

3. In the Range section, choose the Selected Frames option and type 1 to 5 in the From and To fields.
4. Leave the rest of the default options and click OK.
An alert should appear indicating that the scene was sent to the queue.
5. Click OK to close the alert.
Now, open the Render Queue to see if your scene is being processed.
6. In the Environments section, select the environment containing the scene rendering.
7. In the top menu, select Environment > Render Queue.
The Render Queue window opens.
You should see the sample scene listed. Its state will change from "Pending" to "Processing" then to
"Completed" after it has been rendered.
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Vectorizing Scenes or Elements
Before you can paint a scanned drawing in Harmony, you must convert it to a vectorized image format. The
vectorizing process converts the drawings from a bitmap format to a vector line-based format.
Normally, when you scan your drawings, Harmony automatically vectorizes them (sends them to the Vectorize
queue). However, you can also use the Send to Vectorize command to reprocess all drawings for a particular
element. Vectorizing prepares images for painting by creating vector files. You would only have to manually send
scenes to be vectorized in special cases such as:
•

Processing images that were not scanned with the Scan module

•

Reprocessing a scene due to unrecoverable paint errors

To manually vectorize all the drawings for a scene or an element:
1. Select the scene from the Scenes list or select an element from the Elements list.
‣

If you select a scene, Harmony vectorizes all drawings for all elements of that scene.

‣

If you select an element, Harmony vectorizes all the drawings for that selected element.

2. Depending on the component you selected in the previous step in this procedure, follow one of these
steps:
‣

Select the Send to Vectorize command from the Scene menu, or right-click anywhere in the Scenes
list and select Send to Vectorize.

‣

Select the Send to Vectorize command from the Element menu, or right-click anywhere in the
Elements list and select Send to Vectorize.

3. The Confirm dialog box appears.
‣

Click Yes to vectorize all the selected drawings.

‣

Click No to cancel the vectorize command.

The Control Center module sends all drawings in the scene or element to the vectorize queue. To verify how the
processing is progressing, you can display the vectorize queue.

Viewing the Vectorize Queue
The Vectorize queue displays all the drawings that the system is converting to a vector-based format. After the
vectorization of a drawing is finished, the completed drawing disappears from the Vectorize queue.
To view the list of drawings being vectorized:
1. Select an environment name from the list, then select Environment > Vectorize Queue.
The Vectorize Queue window appears.
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2. Select how to sort the entries in the queue from the Sort By drop-down list. You can sort by:
‣

State: sorts the entries based on the item's status (Pending, Pending-E, Processing, or Completed)

‣

Entry time: sorts the entries based on the time you send them for vectorization.

‣

Job, Scene, Element, Drawing

3. If the Vectorize queue has too many entries, you can select a specific Job, scene, element, or drawing that
is in the queue.
Select the items you want to display in the queue from the Show drop-down list. The Show drop-down list
display all the items in the Control Center module's database, not just the ones that have drawings being
vectorized. You have the following choices:
•

Jobs: select the specific Job that is in the queue or has scenes currently being vectorized. If you want to
see all the Jobs, select All Jobs.

•

Scenes: select the specific scene that is in the queue or currently being vectorized. If you want to see all
the scenes a Job, select All Scenes.

4. Select the states you want to display in the queue from the Show States check boxes. The choices are:
‣

Pending: displays the items waiting to be vectorized

‣

Error: displays the items where the system found an error and has stopped vectorizing them (displays
Pending-E as the item's State)

‣

Processing: displays the items that the Harmony is currently processing

‣

Completed: displays the items that were vectorized. However, the Control Center module usually
removes completed items from the Vectorize queue, so this radio button is inactive

‣

Show All States: displays all the items, regardless of their state (Pending, Pending-E, Processing).

5. Select how often you want the queue to check for the latest entries. You have the following choices:
‣

Hold: Display no new entries to the queue once the button is activated.

‣

Monitor: Automatically displays new entries at the interval you enter in the Every ## secs field.

6. Select the Show Error Messages check box if you want to see any related errors for each entry in the
queue.
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If the Control Center module detected any errors while it prepares the drawings, it displays Pending-E in the
State column. These errors can occur if there are files missing, computers are unavailable, or data cannot be
found.

Most of these errors would occur if the system is improperly configured. Therefore, your System
Administrator needs to reconfigure the system to correct the error. If you get a Pending-E error, see
your System Administrator.

Related Topics
•

Modifying Entries in the Vectorize Queue below

Modifying Entries in the Vectorize Queue
When you have a list of entries in your queue, you can modify them in one of the following ways:
•

Change their state in the queue: update a drawing's status in the queue from Processing (which means it
is being vectorized) to Pending (which means the drawing will be vectorized).
After you set a Job as Pending, the Job remains in the queue until a machine becomes available and takes
the job or you delete it from the queue.
Click the Change State to Pending button to change the status of the selected entries in the queue from
Processing to Pending. After a Job becomes Pending, the next available machine will process the entry.
If you want to remove the entry from the queue, you can select the Pending entry and click Delete. If the
entry is Processing, you can delete the entry from the queue but the processing will not stop until the
machine completes it (see note below).

•

•

Change the drawing's processing priority: change the order in which the system vectorizes the drawings
by assigning a priority to each drawing.
•

Click the Change Priority button to change the selected drawings' processing priority in the queue.

•

When the New Priority dialog box appears, drag the scroll bar to increase or decrease the drawing's
vectorize priority.

Remove drawings from the vectorize queue: cancel the vectorize command on selected drawings. When
you remove a drawing from the queue, it only cancels the vectorize request.
•

Click the Delete button to delete the selected drawings from the queue.

You can only modify an entry in the Vectorize queue while it is pending (check the State column in the queue list);
you cannot modify a Job that is being vectorized.
If you must change something about a scene's drawings, you must wait until the vectorizing is complete, then
make your changes and send the drawing to the vectorize queue.

If you must absolutely stop the vectorizing process, you can kill the vectorize process in Windows,
Linux or
Mac OS X.
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Related Topics
•

Stopping a Process on page 89.
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Rendering Your Scenes
When you have finished working on a scene or all of your animated sequence, you can send them to the
rendering queue via Control Center or Harmony Stage. After you render your animation, you can transfer the
scenes to video or film.
After you render a scene, you can mark it as completed using the Change Stage command in the Scene menu.
After you render all the scenes for a particular Job, you can mark the Job as completed using the Change Stage
command in the Job menu.

Changing the job's stage from In Production to Completed only hides the job in the Control Center
window.

Related Topics
•

Viewing the Render Queue below

•

Modifying the Entries in the Render Queue on page 88

•

Changing a Scene's Stage on page 40

•

Changing a Job's Stage on page 31

Viewing the Render Queue
The Render queue displays all the scenes from the selected environment that the system is rendering. After the
system renders a scene, the State of the rendered scene changes to Complete or Completed with Errors and
the scene remains in the queue. If you want to remove the rendered scenes, you must select them and use the
Delete button.
To view the scenes being rendered:
1. Select an environment name from the list, then select Environment > Render Queue.
The Render Queue window appears.
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2. Select how to sort the entries in the queue from the Sort By drop-down list. You have the following
choices:
‣

State: Sorts the entries based on the item's status (Pending, Pending-E, Processing, Completed
with Errors, or Completed).

‣

Entry time: Sorts the entries based on the time you sent them for rendering.

‣

Job, Scene, Element, Drawing

3. Select the components you want to display in the queue from the Show drop-down list. You can choose
the following:
‣

Jobs: select the specific Job you want to see being rendered. If you want to see all the jobs, select All
Jobs.

‣

Scenes: select the specific scene you want to see being rendered. If you want to see all the scenes,
select All Scenes.

4. Select the states you want to display in the queue from the Show States check boxes. You have the
following choices:
‣

Pending: Displays the items waiting to be rendered.

‣

Error: Displays the items where the system found an error and has stopped rendering the item
(displays Pending-E as the item's state).

‣

Processing: Displays the items that the system is currently processing.

‣

Completed: Displays the items that were completely rendered.

‣

Show All States: Displays all the items, regardless of their state (Pending, Pending-E, Processing,
Completed, Completed with Errors).

5. Select how often you want the queue to check for the latest entries. You can press one of these buttons:
‣

Hold: Display any new entries to the queue from the time the Hold button is active.

‣

Monitor: Updates new entries at the interval you enter Every ## secs field (minimum of 2 seconds).

6. Select the Show Error Messages check boxif you want to see any related errors for each entry in the
queue.
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If the Control Center module detects any errors while it processes the scenes, it displays Pending-E
in the State column. Errors can occur if there are files missing, computers are unavailable, or data
cannot be found.
Many of these errors could occur if the system is improperly configured. If you get a Pending-E error,
see your System Administrator as the system may need to be reconfigured.

Modifying the Entries in the Render Queue
After you have a list of entries in your queue, you can modify them in one of the following ways:
1. Change their state in the queue.
This allows you to update the status of a scene, or set of scenes, in the queue from Processing (which
means it is being rendered) to Pending (which means the scenes are waiting to be rendered).
After you set a Job to Pending, the Job remains in the queue until a machine becomes available and takes
the Job or you delete it from the queue.
•

Click the Change State to Pending button to change the status of the selected entries in the queue from
Processing or Completed to Pending.

2. Change the scene's processing priority.
This allows you to change the order in which the system renders the scenes.
•

Click Change Priority to change the selected scene's processing priority in the queue.

•

When the New Priority dialog box appears, drag the scroll bar to increase or decrease the scene's render
priority.

3. Remove scenes from the rendering queue.
This allows you to cancel the render command on selected scenes.
•

Click the Delete button to delete the selected entries from the queue.

You can only modify an entry in the render queue while it is pending (check the State column in the queue list);
you cannot modify a Job that is being rendered.
If you must change something about the scene's drawings, you'll have to wait until the rendering is complete,
make your changes, and send it to the render queue.

If you must absolutely stop the rendering process, you can kill the render process in Windows, Linux
or Mac OS X.
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Stopping a Process
DO NOT STOP THE PROCESS UNLESS ABSOLUTELY NECESSARY.
An example of an extreme case is if you sent 10,000 drawings for vectorization and only one
machine is available to handle the Job (which means it will take hours to complete).
DO NOT ATTEMPT TO STOP THESE PROCESSES YOURSELF. If you must stop a process, see your
System Administrator.

After you send a scene's drawing for vectorization or rendering, you can remove it from the queue easily. If the
process is pending in your vectorize or render queue (check the State column in the queue list), you can simply
remove it by selecting the Job and clicking the Delete button in the Vectorize/Render Queue window.
But once the vectorizing or rendering process actually begins, it gets a bit more complicated to stop the
process.
If you really must stop a rendering or vectorizing Job, you must remove the Job from the Vectorizing or
Rendering queues and then find the actual process in your Windows Task Manager, Linux Shell or Mac OS X
Activity Monitor and kill each task manually.

Related Topics
•

Stopping a Linux Process below

•

Stopping a Windows Process on page 91

Stopping a Linux Process
DO NOT ATTEMPT TO STOP THESE PROCESSES YOURSELF. If you must stop a process, see your System
Administrator.
To kill a vectorize or render process in Linux:
1. Select the job to kill from the Vectorize/Render Queue window and click Delete.
2. As the root user, open a Linux shell and type the following command at the prompt: ps -fe. The shell
window displays all the processes that are active at that moment.

89

Chapter 1: Batch Processing Stopping a Process

3. Find the listing for the vectorizing or rendering process that you launched. There are two ID flags to look
out for:
•

If you launched a vectorizing process, look for the process that lists the word Pix2vec -file
fileLocation.

•

If you launched a rendering process, look for the process that lists the word Stage -job jobName scene sceneName -version versionNumber.

4. Take note of the system number that identifies the process. In the example above, the system numbers
appear in the box on the left.
5. Type the following command and replace <id number> with the system number you noted in the previous
step: kill -9 <id number>
For example, if your process number is 5348 or 5353 (as it is in the example), you would type the following
command to kill the process:
•

kill -9 5353: this command stops the vectorize process.

•

kill -9 5348: this command stops the rendering process.

6. Press [Enter] to launch the kill command.

If you kill a process, but do not delete the Job from the Vectorize or Render queue, the queue
marks the entry as in error (Pending-E) and the entry stays in the queue. This is why it is important to
remove the entry from the queue before you kill the process.
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Stopping a Windows Process
DO NOT ATTEMPT TO STOP THESE PROCESSES YOURSELF. If you must stop a process, see your
System Administrator.

To kill a vectorize or render process on a computer running Windows:
1. Select the Job you want to kill from the Vectorize/Render Queue window and click Delete.
2. Right-click the Windows task bar and select Task Manager from the pop-up menu.
The Task Manager dialog box appears.
3. Click the Processes tab.

4. Rendering or vectorizing launches a process named AnimatePro.exe. Locate it and select it.
5. Click theEnd Process button.
TheTask Manager kills the process and removes it from the Processtab

If you kill a process, but do not delete the job from the Vectorize or Render queue, the queue marks
the entry as in error (Pending-E) and the entry stays in the queue. This is why it is important to
remove the entry from the queue before you kill the process.
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Troubleshooting
If you have any problems running Harmony after installation, review the installation and configuration
instructions to make sure you have followed them completely. If you continue to have problems, consult the
following list to troubleshoot common installation and configuration problems.
•

Problem: No Batch Vectorization or Rendering (Linux) below

•

Problem: No Batch Vectorization or Rendering (Windows) below

•

Problem: No Batch Vectorization or Rendering (Mac OS X) on the facing page

Problem: No Batch Vectorization or Rendering
(Linux)
If drawings are not being vectorized or rendered you should check the setup and configuration of batch
processing.
To check the status of the batch processing machines:
1. In a shell, type Status and press [Enter] twice. The machines that are set up to batch process should
appear in the report. There should be an "R" next to the machine name and the status must be "On" to
be able to batch process.
‣

If no machines appear in the list, make sure the
/USA_DB/schedules/machine-list file lists all of the computers that will do batch vectorization
or rendering. Re-try sending elements to the render queue.

‣

If you still have problems vectorizing and rendering, perhaps the processes were not installed when
you installed Harmony. Re-install Harmony running the -p option. In a shell, change to the directory
where the installation script is stored and type:
./install -p

‣

Make sure that the queues are started. Type the following in a shell:
/sbin/service USAnimation_queues start

To learn more about the Linux installation process, refer to the Toon Boom Harmony LinuxInstallation
guide.

Problem: No Batch Vectorization or Rendering
(Windows)
If drawings are not being vectorized or rendered you should check the status of batch processing machines.
To check the status of the batch processing machines:
1. From the Start menu, select All Programs > Accessories > Command Prompt to open a command
prompt.
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2. Type Status and press [Enter] twice. The machines that are set up to batch process should appear in the
report. There should be an "R" next to the machine name and the status must be "On" to be able to
batch process.
‣

If machines are missing from the report, run the Harmony Configuration Wizard to set up batch
processing on each machine that will vectorize drawings or render scenes. See, Installing Batch
Processing and Configuring the machine-list File (Windows) on page 65

‣

If a machine is in the report, but is set to "Off", you must define a default schedule for the machine.
See, Setting Up Default Schedules on page 79

‣

If a machine is in the report, but is missing the "R", re-start the batch processing queues.

To re-start the batch processing queues:
1. From the Windows Start menu, select Control Panel from the Settings sub-menu.
The Control Panel window appears.
2. Double-click the Toon Boom Harmony Control Panel

icon in the Control Panel window.

The Toon Boom HarmonyControl Panel dialog box appears.
3. From the Process Starter drop-down list, select the tbprocess-schedule entry.

4. Click on the Start button to re-start the service. If the Start button is disabled, click Stop first, wait a
couple of seconds, then click Start.

If you continue to have problems with batch processing, locate the tbprocess.log file and send it to
support@toonboom.com.
•

This file is usually in
\Program Files\Toon Boom Animation\Harmony\nt

Problem: No Batch Vectorization or Rendering (Mac
OS X)
If drawings are not being vectorized or rendered you should check the setup and configuration of batch
processing.
To check the status of the batch processing machines:

‣ In the Terminal, type Status and press [Enter] twice.
The machines that are set up to batch process should appear in the report.
There should be an R next to the machine name and the status must be On to be able to batch process.
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‣

If no machines appear in the list, make sure the /USA_DB/schedules/machine-list file lists all of
the computers that will do batch vectorization or rendering. Re-try sending elements to the render
queue.

‣

If your machine appears in the list, but that there is no R next to it, the tbprocess service may not be
running. Verify that the tbprocess is active by using the steps described in the Verify that a tbprocess
Session is active.

‣

If there is no tbprocess session active, perhaps the processes were not installed when you installed
configured your installation. Verify that the ToonBoomQueueServer folder exists in the
/Library/StartupItems folder. If it does not exist, see the section Starting a tbprocess Session
on Mac OS X.
If the folder exists, start the tbprocess session by typing the following:
sudo /sbin/SystemStarter start ToonBoomQueueServer
The Terminal prompts you to type your password. Your user needs to be allowed to administer this
computer for this command to work.
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Advanced Batch Processing
Once the basic vectorization and rendering batch processing is started, there are more advanced options
possible such as advanced scheduling.

Related Topics
•

About Batch Processing Schedules below

•

Setting Up Default Schedules on page 79

•

Displaying the Schedule Status on the next page

•

Using Default Schedules on page 99

•

Using Periodic Schedules on page 103

•

Using Supervisory Schedules on page 109

•

Shutting Down and Starting Up Environments on page 114

•

A Summary of Scheduling Commands on page 117

About Batch Processing Schedules
By creating a schedule to monitor the batch processing, you can determine which machines perform the batch
processing, and when they perform it. Each batch processing machine on your network has its own set of
schedules and you can view and modify them from any machine on the network.
There are three types of schedules available for a machine:
•

Supervisory Schedule: Assigns a one-time batch processing job to a machine.
For example, you can define a Supervisory Schedule for a machine to perform batch processing work for
the next four hours.
Supervisory Schedules Have the highest priority of the three types of schedules. If you define a
Supervisory Schedule for a specific period of time on a machine, it will perform the batch processing work
according to that schedule, regardless of what the Periodic and Default Schedules define for that period
of time.

•

Periodic Schedule: Assigns recurring batch processing jobs.
For example, you can define a Periodic Schedule for a machine to perform batch processing only on
Saturdays and Sundays.
Periodic Schedules use the days of the week so that you can have batch processing occurring each week
on those specific days
In terms of priority, a Periodic Schedule supersedes a Default Schedule but not a Supervisory
Schedule. If you have a Periodic Schedule active on a machine, that machine performs this type of batch
processing according to its Periodic Schedule before it uses the Default Schedule.

•

Default Schedule: Defines which jobs the machine can process if there are no other schedules defined
Default Schedules have the lowest priority, and are used only when Supervisory and Periodic Schedules
do not exist, or do not define the work to be done for a particular period of time.

When creating or modifying a schedule, you must supply the following information:
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•

Dates and times for which the schedule applies

•

Machine or machines for which the schedule applies

•

Whether batch processing is ON or OFF (whether that machine does or does not perform batch
processing work)

•

The type of batch processing to be done: Vectorize and/or Rendering

•

The environments for which batch processing processes the artwork

•

The priority of the environments to be batch processed (optional)

For any given machine, you can define, clear, and view the Supervisory and Periodic Schedules. You can only
modify or view the Default Schedule for a machine.
You can also shut down and start up environments to stop and start batch processing of a particular
environment on a machine or machines. When you shut down an environment, you are overriding whatever you
already scheduled for it (according to each type of schedule). Therefore, you will effectively stop any batch
processing jobs on the environment until you start up that environment again. You can also view a schedule
status to see an overview of all schedules set for a specified time.

Displaying the Schedule Status
You can monitor which machines are vectorizing or rendering animation data. The schedule status displays an
overview of what each render or vectorize machine is processing at a specific time. The overview also displays a
machine's status based on the highest priority schedule set for the time you select.

You can display this status list by typing the Status command in a Command Shell or Terminal on any machine
in the network. When you run the Status command, you must specify the day and time for which you want to
view the schedule status.
To display the schedule status list, follow these steps:
1. Open a Command Shell or Terminal and type Status.
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You can view the status for one or more machines by listing them after the status command (instead of all
the machines, which is the default). You can also type a prefix to search for machines with names that start
with the same prefix.
For example:
•

Status hp: Shows the status for all machines that begin with "hp".

•

Status cm hp6: Shows the status for all machines that begin with 'cm" and for hp6.

•

Status: Shows the status for all machines.
When you press [Enter], the system prompts you to specify the time for which you want to view the
schedule status.
INPUT BEGIN TIME in 24-hr. format [15:17]:

2. Type the time you want to view the status for in 24-hour format. If you press [Enter] without specifying a
time, the system uses the time displayed in brackets (the current time).
When you press [Enter], the system prompts you for the day for which you want to view the status.
input day [wed]:

3. Type the day of the week for which you want to view the status (you can not enter dates). If you press
[Enter] without entering a day, the system uses the day displayed in brackets (the current day).
The schedule status for the time and day you specified appears.

Reading The Schedule Status List
When you display the Schedule Status list, the information appears in three separate sections:
•

Key: Lists the abbreviations the status schedule uses for the Environments, the two types of batch
processes you can schedule on a machine, and the abbreviations the other columns use in the list.

•

SCHEDULE STATUS: Displays the processing status of each Rendering or Vectorizing machine in the
network.

•

Summary: (Appears directly below the Schedule Status section) displays a summary of which
machines are performing a specific type of batch processing (vectorize or render).

The following table describes the contents of the SCHEDULE STATUS list:
Column Title

Description

R

The first column displays an R for each machine that has the
tbprocess program running on it. tbprocess must be
running on a machine in order for that machine to do batch
process work.
For more information on starting tbprocess on Linux, see
Starting the Batch Processing Queue on Linux on page 74.
For more information on starting tbprocess on Windows,
see Starting the Batch Processing Queue on Windows on
page 72.
If an R does not appear for a machine, the SCHEDULE
STATUS list displays what would be scheduled if the
tbprocess program was running on it.
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Column Title

Description

SD

The second column displays if an Environment is shut down
for batch processing on that machine.
You can specify that certain machines don't process
Environments by selecting which machines should be shut
down (or turned off).
An asterisk (*) appears in the SD column to indicate that one
or more Environments have been shut down for that
machine. For more details on how to shut down
Environments, see Shutting Down and Starting Up
Environments on page 114.

machine

The third column displays the name of the networked
machine that is configured to accept batch processing Jobs.

state

The fourth column indicates whether the machine is ON or
OFF.
ON: the machine is scheduled to batch process.
OFF: the machine is not scheduled (for the time you
specified) to batch process.

vec
status

The fifth and sixth columns list the type of batch processing
the machine is scheduled to do (Vectorize batch processing
and/or Render batch processing).
If an asterisk (*) appears in these columns for a machine, then
this type of batch processing is scheduled for this machine.
If a machine is scheduled to do both types of batch
processing, the machine performs both types alternatively; it
processes an entry from the Vectorize Queue, vectorizes
the data, and then take an entry from the Render Queue.

Environments

The seventh column displays the Environments that are
scheduled to be batch processed on a machine.
The machine batch processes only the data from the
Environments listed in this column.

pri

This eighth column displays the priority level for batch
processing on a machine. You can prioritize Environments so
that one machine can perform the batch processing before
another.
If an asterisk (*) appears in the pri column, the
Environments are prioritized for that machine. The priority
order for the environments appears in the Environments
column (reads from left to right, highest to lowest priority).

nexteventTime

This final column displays the date and time of the next
status change for that machine, according to the defined
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Column Title

Description
batch processing schedules.
For example, even though the hickey machine is OFF at the
moment, the Time column displays the next time its status
will change is at 12:53 on Wednesday, March 8th. This can
indicate that a Periodic or Supervisory Schedule is set for this
machine.

Using Default Schedules
A Default Schedule sets batch processing for a machine when no other schedules are in effect. For example, if
there are no Supervisory or Periodic Schedules that affect a particular machine on Monday at 9:00 AM, the
Default Schedule determines the type of batch processing that this machine performs at that time.
Every Harmony system machine uses a Default Schedule to determine when it should perform batch processing.
You can display or modify the Default Schedules for any machine in the Harmony system.

Related Topics
•

Displaying Default Schedules below

•

Modifying Default Schedules on page 101

Displaying Default Schedules
When you display a Default Schedule, you can see all the batch processing machines on the network and when
they are scheduled to perform the batch processing work. The Default Schedule also displays the type of batch
processing work (vectorize or render) and which environments are scheduled for the processing work.
After you display the default schedule, you can modify it to change the time, type of batch processing, or
environments to process. For more information on modify the Default Schedule using the Setdef command, see
Modifying Default Schedules on page 101.
To display a Default Schedule, follow these steps:
1. Type Showdef in a Linux shell and press [Enter]. The system prompts you for the machine or machines
whose Default Schedule you want to see.
INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all [all]:

2. Select which machines to view by typing the name of a single machine, a prefix (to select a range of
machines that start with the same prefix), or all to view all the Default Schedules for all the machines.
If you press [Enter] without specifying a machine, the command uses the machine name that appears in
brackets.
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If you type a prefix, a list of machines that contain that prefix appears. Type the numbers that
correspond to the machines you want to view.
For example, if you have three machines that start with "hi", you can type hi as a prefix. The system
would then display a list of all the machines that start with"hi":
input a set of machines, or hit return to indicate all these machines:
1 = hickey, 2 = highlander, 3=high-definition
You can either press [Enter] to select all the machines in the list or you can select certain machines by
typing their corresponding numbers.

The command then prompts you to ask if you want to view more machines.
DO YOU WANT TO INPUT MORE MACHINES (y/n) [n]:

3. Decide if you want to view more environments and machines.
•

Type y to select more machines and press [Enter].

•

Type n to not select any more machines and press [Enter].
The Default Schedule for the selected machines appears.

Related Topics
•

Reading The Default Schedule Status List below

Reading The Default Schedule Status List
When you display the Default Schedule Status list, the system displays the information in two sections:
•

Key: lists the abbreviations used in the status schedule for the environments, the two types of batch
processes you can schedule on a machine, and the abbreviations used for the other columns in the list.

•

DEFAULT SETTINGS: displays the processing status of each Rendering or Vectorizing machine in the
network.
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The following table describes the contents of the SCHEDULE STATUS list.
Column Title

Description

Machine

The first column displays the name of the networked machine that is
configured to accept batch processing jobs.

Status

This second column indicates whether the machine is available for batch
processing.
ON: the machine is scheduled to batch process.
OFF: the machine is not scheduled (for the time you specified) to batch
process.
The third and fourth columns list the type of batch processing the machine
is scheduled to do (Vectorize batch processing and/or Render batch
processing).

vec
ren

If an asterisk (*) appears in these columns for a machine, then this type of
batch processing is scheduled for this machine.
If a machine is scheduled to do both types of batch processing, the machine
performs both types alternatively; it processes an entry from the Vectorize
Queue, vectorizes the data, and then takes an entry from the Render
Queue.
environments

This fifth column displays the environments that are scheduled to be batch
processed on a machine.
The schedule batch processes only the data from the environments listed in
this column.

pri

This sixth column displays the priority level for batch processing on a
machine. You can prioritize environments so that one machine can perform
the batch processing before another.
If an asterisk (*) appears in the pri column, the environments are
prioritized for that machine. The priority order for the environments
appears in the environments column (reads from left to right, highest to
lowest priority).

Time of Last Update

The Default Schedule also indicates the last time the schedule was modified
for each machine.
This final column displays the date and time of the last time the default
schedule was modified for each machine.

Modifying Default Schedules
When you are ready to modify your default schedule, you need to specify the following pieces of information:
•

the machine(s) you want to update

•

the type of batch processing work you want to assign

•

the environments to process
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After you modify the default schedule, you can use the Showdef command to view your changes. For more
information on viewing the Default Schedule using the Showdef command, see Displaying Default Schedules on
page 99.
To modify a Default Schedule, follow these steps:
1. In a Terminal, Command Prompt or Linux shell, type Setdef and press [Enter]. The system prompts you
for the machine or machines whose Default Schedule you want to modify.
INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all [all]:

2. Select the machines you want to modify by typing the name of a single machine, a prefix (to select a range
of machines that start with the same prefix), or all to modify all the Default Schedules for all the
machines.
If you press [Enter] without specifying a machine, the command uses the machine name that appears in
brackets.

If you type a prefix, a list of machines that contain that prefix appears. Type the numbers that
correspond to the machines you want to modify.
For example, if you have three machines that start with "hi", you can type hi as a prefix. The system
would then display a list of all the machines that start with "hi":
input a set of machines, or hit return to indicate all these
machines:
1 = hickey, 2 = highlander, 3=high-definition
You can either press [Enter] to select all the machines in the list or you can select certain machines by
typing their corresponding numbers.

The command asks if you want to modify the Default Schedule for more machines.
DO YOU WANT TO INPUT MORE MACHINES (y/n) [n]:

3. Decide if you want to modify the Default Schedule on other machines.
•

Type y to select more machines and press [Enter]. The system prompts you to select other machines (see
step 1 of this procedure).

•

Type n to not select any more machines and press [Enter].
The system prompts you to select if you want vectorizing work performed on the machine.
INPUT TYPE OF WORK ALLOWED is vectorize work allowed (y/n) [yes]

4. Select if you want the machines to perform vectorizing work on the selected machines.
•

Type y to schedule Vector batch processing and press [Enter].

•

Type n to not schedule Vector batch processing and press [Enter].

•

If you press [Enter] without entering y or n, the prompt uses the answer shown in brackets.
The system then prompts you to select if you want rendering work performed on the machine.
is render work allowed (y/n) [yes]

5. Select if you want the machines to perform rendering work on the selected machines.
•

Type y to schedule Render batch processing and press [Enter].
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•

Type n to not schedule Render batch processing and press [Enter].

•

If you press [Enter] without entering y or n, the prompt uses the answer shown in brackets.
You are prompted to select the environments to be scheduled for batch processing.
INPUT A SET OF DATABASE ENVIRONMENTS
1 = Production, 2 = Tutorials, 3 = Commercials default - [Production Commercials]

All the environments in your system appear in this list, each one assigned to a number.
6. Type the number that corresponds to the environment(s) you want to schedule and press [Enter]. If you
press [Enter] without typing anything, the system uses the environments listed in brackets.
If you select more than one environment, the system asks if you want to establish a priority.
should processing of the DBenv's be prioritized? (y/n) [yes]

You can prioritize your environments so that batch processing works on the highest priority environment
first. If you do not define a priority, the batch processing does an equal amount of work for each
environment.
The order in which you type the environment numbers can determine their batch processing priority in the
schedule (the first environment you type has the highest priority). However, the order in which you type
the environments is not important if you don't want to prioritize the environments (by answering no to
the system prompt).
In this example, if you want to schedule only the Production and Tutorials environments for batch
processing, you would type: 1 2, indicating that Production has a higher priority than Tutorials for
batch processing.
7. Select if you want to assign a priority to the environments you selected. If you press [Enter] without
entering anything, the system uses the answer shown in brackets.
•

Type y to prioritize batch processing.

•

Type n to not prioritize batch processing.
The system prompts you to schedule the status of the machine(s).
input ON or OFF [on]:

8. Select if you want to apply the Default Schedule right away, making the machines available immediately.
•

Type on to make the machines available for batch processing according to their defined Default
Schedules and press [Enter].

•

Type off to make the machines unavailable for batch processing, regardless of their defined Default
Schedules, and press [Enter].

•

If you press [Enter] without entering on or off, the prompt uses the answer shown in brackets.

The Default Schedule for the specified machines is set. The new schedule appears.

Using Periodic Schedules
The Periodic Schedule is an optional schedule that defines a recurring period of time when a machine will perform
batch processing. You can create a Periodic Schedule by specifying a day of the week (Monday, Tuesday, etc.)
and the machine will perform batch processing on the specified days for every week.
A Periodic Schedule lists batch processing jobs for which you must define a start and end date, and time. Each
job has its own set of batch processing parameters that are independent of the other jobs in the schedule.
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For example, you can create a Periodic Schedule for a machine so that it performs batch processing every night
from 20:00 that evening to 08:00 the following morning. Therefore, the machine would not perform batch
processing work during the day when the users would be present.

The Periodic Schedule is between the Default Schedule and the Supervisory Schedule in terms of
priority. If there are no Supervisory Schedules for a machine, or the Supervisory Schedule does not
define the work to be done for a particular period of time, the machine uses the Periodic Schedule.
However, if you have an active Supervisory Schedule, the machine follows this schedule before it
follows either the Periodic or Default schedules.

Related Topics
•

Displaying Periodic Schedules below

•

Setting a Periodic Schedule on the facing page

•

Clearing a Periodic Schedule on page 108

•

Using Default Schedules on page 99.

•

Using Supervisory Schedules on page 109.

Displaying Periodic Schedules
When you display a Periodic Schedule, you can see all the batch processing machines that use this schedule and
when they are scheduled to perform the batch processing. The Periodic Schedule also displays the type of batch
processing work (vectorize or render) and the environments that are scheduled for the processing work.
After you display the Periodic Schedule, you can modify it to change the time, type of batch processing, or
environments to process. For more information on modify the Periodic Schedule using the Setper command,
see Setting a Periodic Schedule on the facing page.

You can only display the Periodic Schedule for one machine at a time.

To display a Periodic Schedule, follow these steps:
1. Type Showper in a Linux shell and press [Enter]. The system prompts you for the machine whose Periodic
Schedule you want to view.
INPUT MACHINE [hickey]:

2. Type the name of the machine for which you want to define a Periodic Schedule. If you press [Enter]
without specifying a machine, the command uses the machine name that appears in brackets.

104

Toon Boom Harmony 10.3 Control Center and Server Guide

You can combine these two steps by adding the name of the machine you want to view at the end of
the Showper command.
For example, if the machine you want to view is called hickey, then you would type the following
command in a Linux shell to view its periodic schedule:

Showper hickey
The Periodic Schedule for that machine appears.

Setting a Periodic Schedule
When you are ready to modify your Periodic Schedule, you need to specify the following pieces of information:
•

The machine(s) for which you want to create or update the periodic schedule(s)

•

The type of batch processing work you want to assign

•

The environments to process

•

When to start and stop the batch process

You can add jobs to the schedule if a Periodic Schedule already exists for a particular machine, or you can clear
out any pre-existing jobs before setting new jobs in the schedule. You can clear a Periodic Schedule without
setting any new jobs (see Clearing a Periodic Schedule on page 108).
To define a Periodic Schedule on a machine, follow these steps:
1. Type Setper in a Linux shell and press [Enter]. The system prompts you for the machine or machines
whose Periodic Schedule you want to modify.
INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all [all]:
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2. Select the machines you want to modify by typing the name of a single machine, a prefix (to select a range
of machines that start with the same prefix), or all to modify all the Periodic Schedules for all the
machines.
If you press [Enter] without specifying a machine, the command uses the machine name that appears in
brackets.

If you type a prefix, a list of machines that contain that prefix appears. Type the numbers that
correspond to the machines you want to modify.
For example, if you have three machines that start with "hi", you can type hi as a prefix. The system
would then display a list of all the machines that start with "hi":
input a set of machines, or hit return to indicate all these
machines:
1 = hickey, 2 = highlander, 3=high-definition
You can either press [Enter] to select all the machines in the list or you can select certain machines by
typing their corresponding numbers.

The command then prompts you to ask if you want to modify the Periodic Schedule on more machines.
DO YOU WANT TO INPUT MORE MACHINES (y/n) [n]:

3. Decide if you want to modify the Periodic Schedules for other machines.
•

Type y to select more machines and press [Enter]. The system prompts you to select other machines (see
step 1 of this procedure).

•

Type n to not select any more machines and press [Enter].
The system prompts you to clear the existing schedule before defining new entries.
WOULD YOU LIKE TO CLEAR THE SCHEDULE OF PRE-EXISTING ENTRIES? (y/n) [n]:

4. Decide if you want to remove the existing schedule or not.
•

Type y to remove any existing schedules on the machine(s).

•

Type n to preserve any existing schedules on the machine(s). The system will add your new entries to the
existing set of entries.
You are then asked if you would like to schedule any new entries.
WOULD YOU LIKE TO SCHEDULE ANY ENTRIES? (y/n) [y]

5. Decide if you want to schedule new entries in your Periodic schedule or not.
•

Type y to schedule new entries. Proceed to the next step to define the schedule.

•

Type n to not schedule any new entries. This cancels the Setper command without scheduling any new
entries; the command returns you to the shell prompt.

6. If you typed y to the previous prompt, the command prompts you activate or deactivate the selected
machines.
input ON or OFF [on]:

•

Type on to activate the Periodic Schedule for the selected machines.
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•

Type off to deactivate the Periodic Schedule for the selected machines. The machine(s) will not perform
any Periodic batch processing, regardless of what the other Periodic entries have been scheduled.
The system prompts you to select if you want vectorizing work performed on the machine.
INPUT TYPE OF WORK ALLOWED is vectorize work allowed (y/n) [no]

7. Decide if you want the machines to perform vectorizing work on the selected machines.
•

Type y to schedule Vector batch processing and press [Enter].

•

Type n to not schedule Vector batch processing and press [Enter].

•

If you press [Enter] without entering y or n, the prompt uses the answer shown in brackets.
The system then prompts you to select if you want rendering work performed on the machine.
is render work allowed (y/n) [yes]

8. Decide if you want the machines to perform rendering work on the selected machines.
•

Type y to schedule Render batch processing and press [Enter].

•

Type n to not schedule Render batch processing and press [Enter].

•

If you press [Enter] without entering y or n, the prompt uses the answer shown in brackets.
You are prompted to select the environments to be scheduled for batch processing. All the environments
in your system appear in this list, each one assigned to a number.
INPUT A SET OF DATABASE ENVIRONMENTS
1 = Production, 2 = Tutorials, 3 = Commercials default - [Production Commercials]

9. Type the number that corresponds to the environment(s) you want to schedule and press [Enter]. If you
press [Enter] without typing anything, the system uses the environments listed in brackets.
If you select more than one environment, the system asks if you want to establish a priority.
should processing of the DBenv's be prioritized? (y/n) [yes]

You can prioritize your environments so that batch processing works on the highest priority environment
first. If you do not define a priority, the batch processing does an equal amount of work for each
environment.
The order in which you type the environment numbers can determine their batch processing priority in the
schedule (the first environment you type has the highest priority). However, the order in which you type
the environments is not important if you don't want to prioritize the environments (by answering no to
the system prompt).
In this example, if you want to schedule only the Production and Tutorials environments for batch
processing, you would type: 1 2, indicating that Production has a higher priority than Tutorials for
batch processing.
10. Select if you want to assign a priority to the environments you selected. If you press [Enter] without
entering anything, the system uses the answer shown in brackets.
•

Type y to prioritize batch processing.

•

Type n to not prioritize batch processing.
The scheduler prompts you to define the time and day when to start the Periodic batch processing.
INPUT BEGIN TIME in 24-hr. format [15:17] input day [wed]:
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11. Type the time (in 24-hour format) and day (in day of the week format) when to begin batch processing and
press [Enter].
If you press [Enter] without entering anything, the scheduler uses the time and day that appear in
brackets.
The scheduler prompts you for the end time.
INPUT END TIME in 24-hr. format: input day [thu]:

12. Type the time (in 24-hour format) and the day (in day of the week format) when to stop the batch
processing and press [Enter].
A summary of the job you just scheduled appears. The scheduler then prompts you to confirm that you
want to enter this job in the schedule.

13. Decide if you want create this scheduled job in your Periodic Schedule.
•

Type y if you want to add this job into your Periodic Schedule and press [Enter]

•

Type n if you do not want to add this job into your Periodic Schedule and press [Enter].
The scheduler gives you the opportunity to add another job to your Periodic Schedule.
DO YOU WANT TO SCHEDULE ANOTHER EVENT (y/n) [y]

14. Decide if you want to add another job to your Periodic Schedule.
•

Type y to add another job and press [Enter]. Repeat steps 7 to 13.

•

Type n if you do not want to enter another job and press [Enter].

When you finish add jobs to the Periodic Schedule, a summary of the entire Periodic Schedule appears.

Clearing a Periodic Schedule
If you decide you don't need to have anymore recurring batch jobs, you can clear the scheduled jobs from the
Periodic Schedule. Once the Periodic Schedule is empty, the batch jobs in the Default Schedule come into effect.
You can clear existing jobs from a Periodic Schedule without creating any new jobs. However, when you clear a
Periodic Schedule, you clear all of the jobs that exist for that schedule.
To clear your Periodic Schedule, simply follow Type Setper in a Linux shell and press [Enter]. The system
prompts you for the machine or machines whose Periodic Schedule you want to modify.Decide if you want
to remove the existing schedule or not. listed in Setting a Periodic Schedule on page 105 , then follow
these steps:
1. Type y when you reach the following prompt:
WOULD YOU LIKE TO CLEAR THE SCHEDULE OF PRE-EXISTING ENTRIES? (y/n) [n]

2. Type n when you reach the following prompt:
WOULD YOU LIKE TO SCHEDULE ANY ENTRIES? (y/n) [y]

This clears the Periodic Schedule and displays an empty schedule, confirming that the system cleared the
jobs.
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Using Supervisory Schedules
A Supervisory Schedule forces a machine to perform batch processing for a non-recurring period of time. This
type of schedule, like the Periodic Schedule, is optional. If you have a Supervisory Schedule active for a period of
time, the machine performs batch processing according to that schedule before it references the Periodic or
Default schedules.
For example, you could force a machine to perform only Vectorize batch processing for the next 4 hours,
ignoring any other scheduled type of batch processing during that time.
A Supervisory Schedule consists of a list of batch processing jobs for which you must define a start and end date
and time. Each job has its own set of batch processing parameters that are independent of the other jobs in the
schedule.

The Supervisory Schedule holds the highest priority level, superseding the Periodic Schedule and
Default Schedule. Therefore, if you have an active Supervisory Schedule, the machine follows this
schedule before it follows either the Periodic or Default schedules.

Related Topics
•

Displaying Supervisory Schedules below

•

Setting a Supervisory Schedule on the next page

•

Clearing a Supervisory Schedule on page 113

•

Using Default Schedules on page 99.

•

Using Periodic Schedules on page 103.

Displaying Supervisory Schedules
When you display a Supervisory Schedule, you can see all the batch processing machines that use this schedule
and when they are scheduled to perform the batch processing. The Supervisory Schedule also displays the type
of batch processing work (vectorize or render) and the environments that are scheduled for the processing
work.
After you display the Supervisory Schedule, you can modify it to change the time, type of batch processing, or
environments to process. For more information on modifying the Supervisory Schedule using the Setsup
command, see Setting a Supervisory Schedule on the next page.
You can display the Supervisory Schedule for only one machine at a time.
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To display a Supervisory Schedule, follow these steps:
1. Type Showsup in a Linux shell and press [Enter]. The system prompts you for the machine whose
Supervisory Schedule you want to view.
INPUT MACHINE [hickey]:

2. Type the name of the machine for which you want to define a Supervisory Schedule. If you press [Enter]
without specifying a machine, the command uses the machine name that appears in brackets.

You can combine these two steps into one by adding the name of the machine you want to view at
the end of the Showsup command.
For example, if the machine you want to view is called hickey, then you would type the following
command in a Linux shell to view its Supervisory Schedule.

Showsup hickey

The Supervisory Schedule for the machine appears.

Setting a Supervisory Schedule
When you are ready to modify your Supervisory Schedule, you need to specify the following:
•

The machine(s) for which you want to create or update the supervisory schedule(s)

•

The type of batch processing work you want to assign

•

The environments to process

•

When to start and stop the batch process
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You can add jobs to the schedule if a Supervisory Schedule already exists for a particular machine, or you can
clear out any pre-existing jobs before setting new jobs in the schedule. You can clear a Supervisory Schedule
without setting any new jobs (see Clearing a Supervisory Schedule on page 113).
To define a Supervisory Schedule on a machine, follow these steps:
1. Type Setsup in a Linux shell and press [Enter]. The system prompts you for the machine or machines
whose Supervisory Schedule you want to modify.
INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all [all]:

2. Select the machines you want to modify by typing the name of a single machine, a prefix (to select a range
of machines that start with the same prefix), or all to modify all the Supervisory Schedules for all the
machines.
If you press [Enter] without specifying a machine, the command uses the machine name that appears in
brackets.

If you type a prefix, a list of machines that contain that prefix appears. Type the numbers that
correspond to the machines you want to modify.
For example, if you have three machines that start with "hi", you can type hi as a prefix. The system
would then display a list of all the machines that start with "hi" :
input a set of machines, or hit return to indicate all these
machines:
1 = hickey, 2 = highlander, 3=high-definition
You can either press [Enter] to select all the machines in the list or you can select certain machines by
typing their corresponding numbers.

The command then prompts you to ask if you want to modify the Supervisory Schedule on more machines.
DO YOU WANT TO INPUT MORE MACHINES (y/n) [n]:

3. Decide if you want to modify the Supervisory Schedules for other machines.
•

Type y to select more machines and press [Enter]. The system prompts you to select other machines (see
step 1 of this procedure).

•

Type n to not select any more machines and press [Enter].
The system prompts you to clear the existing schedule before defining new entries.
WOULD YOU LIKE TO CLEAR THE SCHEDULE OF PRE-EXISTING ENTRIES? (y/n) [n]:

4. Decide if you want to remove the existing schedule or not.
•

Type y to remove any existing schedules on the machine(s).

•

Type n to preserve any existing schedules on the machine(s). The system will add your new entries to the
existing set of entries.
You are then asked if you would like to schedule any new entries.
WOULD YOU LIKE TO SCHEDULE ANY ENTRIES? (y/n) [y]

5. Decide if you want to schedule new entries in your Supervisory schedule or not.
•

Type y to schedule new entries. You can proceed to the next step to define the schedule.
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•

Type n to not schedule any new entries. This cancels the Setsup command without scheduling any new
entries; the command returns you to the shell prompt.

6. If you typed y to the previous prompt, the command prompts you activate or deactivate the selected
machines.
input ON or OFF [on]:

•

Type on to activate the Supervisory Schedule for the selected machines.

•

Type off to deactivate the Supervisory Schedule for the selected machines. The machine(s) will not
perform any Supervisory batch processing, even if the Supervisory schedule has jobs in it.
The system prompts you to select if you want vectorizing work performed on the machine.
INPUT TYPE OF WORK ALLOWED is vectorize work allowed (y/n) [no]

7. Decide if you want the machines to perform vectorizing work on the selected machines.
•

Type y to schedule Vector batch processing and press [Enter].

•

Type n to not schedule Vector batch processing and press [Enter].

•

If you press [Enter] without entering y or n, the prompt uses the answer shown in brackets.
The system then prompts you to select if you want rendering work performed on the machine.
is render work allowed (y/n) [yes]

8. Decide if you want the machines to perform rendering work on the selected machines.
•

Type y to schedule Render batch processing and press [Enter].

•

Type n to not schedule Render batch processing and press [Enter].

•

If you press [Enter] without entering y or n, the prompt uses the answer shown in brackets.
You are prompted to select the environments to be scheduled for batch processing. All the environments
in your system appear in this list, each one assigned to a number.
INPUT A SET OF DATABASE ENVIRONMENTS
1 = Production, 2 = Tutorials, 3 = Commercials default - [Production Commercials]

9. Type the number that corresponds to the environment(s) you want to schedule and press [Enter]. If you
press [Enter] without typing anything, the system uses the environments listed in brackets.
If you select more than one environment, the system asks if you want to establish a priority.
should processing of the DBenv's be prioritized? (y/n) [yes]

You can prioritize your environments so that batch processing works on the highest priority environment
first. If you do not define a priority, the batch processing does an equal amount of work for each
environment.
The order in which you type the environment numbers can determine their batch processing priority in the
schedule (the first environment you type has the highest priority). However, the order in which you type
the environments is not important if you don't want to prioritize the environments (by answering no to
the system prompt).
In this example, if you want to schedule only the Production and Tutorials environments for batch
processing, you would type: 1 2, indicating that Production has a higher priority than Tutorials for
batch processing.
10. Select if you want to assign a priority to the environments you selected. If you press [Enter] without
entering anything, the system uses the answer shown in brackets.
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•

Type y to prioritize batch processing.

•

Type n to not prioritize batch processing.
The scheduler prompts you to define the time and day when to start the Supervisory batch processing.
INPUT BEGIN TIME in 24-hr. format [15:17] input day [wed]:

11. Type the time (in 24-hour format) and day (in day of the week format) when to begin batch processing and
press [Enter].
If you press [Enter] without entering anything, the scheduler uses the time and day that appear in the
brackets.
The scheduler prompts you for the end time.
INPUT END TIME in 24-hr. format: input day [thu]:

12. Type the time (in 24-hour format) and the day (in day of the week format) when to stop the batch
processing and press [Enter].
If you press [Enter] without entering anything, the scheduler uses the time and day that appear in the
brackets.
A summary of the job you just scheduled appears. The scheduler then prompts you to confirm that you
want to enter this job in the schedule.

13. Decide if you want create this scheduled job in your Supervisory Schedule.
•

Type y if you want to add this job into your Supervisory Schedule and press [Enter]

•

Type n if you do not want to add this job into your Supervisory Schedule and press [Enter].
The scheduler gives you the opportunity to add another job to your Supervisory Schedule.
DO YOU WANT TO SCHEDULE ANOTHER EVENT (y/n) [y]

14. Decide if you want to add another job to your Supervisory Schedule.
•

Type y to add another job and press [Enter]. Repeat steps 7 to 13.

•

Type n if you do not want to enter another job and press [Enter].

When you finish add jobs to the Supervisory Schedule, a summary of the entire Supervisory Schedule appears.

Clearing a Supervisory Schedule
If you decide you don't need to set a Supervisory Schedule for your batch processing jobs, you can clear the
scheduled jobs from the Supervisory Schedule. Once the Supervisory Schedule is empty, the batch processing
jobs in the Periodic and Default Schedules come into effect.
You can clear existing jobs from a Supervisory Schedule without creating any new jobs. However, when you clear
a Supervisory Schedule, you clear all of the jobs that exist for that schedule.
To clear your Supervisory Schedule, simply follow Type Setsup in a Linux shell and press [Enter]. The system
prompts you for the machine or machines whose Supervisory Schedule you want to modify. to Step3Decide if you
want to remove the existing schedule or not. listed in Setting a Supervisory Schedule on page 110, but type y
when you reach the following prompt:
WOULD YOU LIKE TO CLEAR THE SCHEDULE OF PRE-EXISTING ENTRIES? (y/n) [y]
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This clears the Supervisory Schedule and displays an empty schedule, confirming that the system cleared the
jobs.

Shutting Down and Starting Up Environments
In some cases, you must shut down a machine so that it does not process any batch Jobs from an Environment or
for a specific amount of time. For example, to shut down batch processing for all Environments on a single
machine so that you can reboot that machine. Or you can shut down one Environment on all machines so you can
move scenes in that Environment to other machines.
To determine if an Environment is shut down on a particular machine, type Status in a Command Shell or
Terminal. If you see an asterisk (*) in the SD column for a particular machine, this means at least one Environment
is shut down on that machine.
You can view the Supervisory and Periodic schedules for the shut down machines to isolate which Environments
are shut down.

Related Topics
•

Using Supervisory Schedules on page 109.

•

Using Supervisory Schedules on page 109.

Shutting Down Environments
When you shut down an Environment, this overrides whatever was scheduled for that Environment (for all three
types of schedules). The Environment remains shut down until you reinstate it by typing Suenv command in a
Command Shell or Terminal (see Starting Up Environments on the facing page). You can shut down multiple
Environments on multiple machines, from any machine in the network.
When shutting down an Environment, the command prompts you for the Environments you want to close and
the machines on which you want them to be shut down.
To shut down an Environment on a machine, follow these steps:
1. Type Sdenv in a Command Shell or Terminal. The command prompts you for the Environments to shut
down:
INPUT DATABASES TO BE STOPPED
INPUT A SET OF DATABASE Environments
1 = Production, 2 = Tutorials, 3 = Commercials, default = [Production
Tutorials Commercials]
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All the Environments appear in this list and each one has its own number.
2. Type the number that corresponds to each Environment you want to shut down (separate each number
by a space) and press [Enter].
The command prompts you for the machine or machines on which you want the Environments to be shut
down:
INPUT MACHINE ON WHICH THESE DBENV'S ARE TO BE SHUTDOWN
INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all
[hickey]:
3. Select which machines should not process the shut down Environment by typing the name of a single
machine, a prefix (to select a range of machines that start with the same prefix), or all to shut down all
the Environments on all the machines.
If you press [Enter] without specifying a machine, the command uses the machine name that appears in
brackets.

If you type a prefix, a list of machines that contain that prefix appears. Type the numbers that
correspond to the machines you want to shut down.
For example, if you have three machines that start with "hi", you can type hi as a prefix. The system
would then display a list of all the machines that start with "hi":
input a set of machines, or hit return to indicate all these
machines:1 = hickey, 2 = highlander, 3=high-definition
Either press [Enter] to select all the machines in the list or select machines by typing their
corresponding numbers.

The command then prompts you to ask if you want to shut down more machines.
DO YOU WANT TO INPUT MORE MACHINES (y/n) [n]:

4. Decide if you want to shut down more Environments and machines.
•

Type y to select more machines and press [Enter].

•

Type n to not select any more machines and press [Enter].

When you finish, a summary of the shutdown appears:
here are the 3 machines you input: hickey weiner garneau
ALL MACHINES HAVE REPORTED. SHUT DOWN COMPLETE.
The Sdenv command waits for a response from all the selected machines. The Sdenv command does not
terminate a batch process that is currently running on a machine. If a machine is currently performing a batch
process, it will not shut down until it completes the queue entry.

Starting Up Environments
When you are ready to re-start the batch process on an Environment that was shut down, you can use the Suenv
command. When you restart an Environment, the command prompts you for the Environments you want to start
up and the machines you want them to start running on.
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If you accidentally restart an environment that is already active, nothing happens.

To start up an environment, follow these steps:
1. Type Suenv in a Command Shell or Terminal and press [Enter]. The command prompts you for the
Environments you want to restart:
INPUT DATABASES TO BE STARTEDINPUT A SET OF DATABASE Environments
1 = Production, 2 = Tutorials, 3 = Commercials, default = []
All the Environments in your system appear in this list and each one has a number.
2. Type the numbers that correspond to each Environment you want to restart (separate each number by a
space) and press [Enter].
You are prompted for the machine or machines to want to process the Environments:
INPUT MACHINE ON WHICH THESE DBENV'S ARE TO BE STARTED
INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all
[hickey]:
3. At the prompt, select which machines should process the Environment by typing the name of a single
machine, a prefix (to select a range of machines that start with the same prefix), or all to restart all the
Environments on all the machines.
If you press [Enter] without specifying a machine, the command uses the machine name that appears in
brackets.

If you type a prefix, a list of machines appears that contain that prefix. Type the numbers that
correspond to the machines you want to restart.
For example, if you have three machines that start with "hi", you can type hi as a prefix. The system
would then display a list of all the machines that start with "hi":
input a set of machines, or hit return to indicate all these
machines:
1 = hickey, 2 = highlander, 3=high-definition
Either press [Enter] to select all the machines in the list or select machines by typing their
corresponding numbers.

The command then ask if you want to restart Environments on more machines.
DO YOU WANT TO INPUT MORE MACHINES (y/n) [n]:

4. Decide if you want to restart Environments on more machines.
•

Type y to select more machines and press [Enter].

•

Type n to not select any more machines and press [Enter].

When you finish, a summary of the started machines appears:
here are the 3 machines you input: hickey weiner garneau
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ALL MACHINES HAVE REPORTED. STARTUP COMPLETE.

A Summary of Scheduling Commands
The following table summarizes the batch processing scheduling commands and parameters that were covered
in more detail in this chapter.
Command

Effect

Status

Displays the Schedule Status (default for all machines).
Options

[machine]: limits the display to specified machines
(separate machine names with spaces).
[prefix]: limits the display to machines with specified
prefix.
Showdef

Displays Default Schedules.

Setdef

Modifies Default Schedules.

Showper

Displays Periodic Schedule (for a single machine only).
Options

[machine]: specifies the machine for which you wish to
display the Periodic Schedule.
Setper

Sets and/or clears Periodic Schedules.

Showsup

Displays Supervisory Schedule (for a single machine only).
Options

[machine]: specifies the machine for which you wish to
display the Supervisory Schedule.
Setsup

Sets and/or clears Supervisory Schedules.

Sdenv

Shuts Down environments.

Suenv

Starts Up environments.

start_process_starter

Starts Process running on a machine (you must be logged
into the machine, and should be SuperUser when running
this command).

tail -options file

Displays last 10 lines of specified file (Linux).
Options

-n: specifies the number of line from the file to display
-f: Updates the display as the file changes (must use [Ctr]l +
[C] or [Break] key to quit)
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Command

Effect

ps

Displays active processes of current user (Linux).
Options

-f: displays full listing
-u [username]: limits display to specified Linux user name
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